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KATA PENGANTAR

Modul ini dibuat dalam rangka pelatihan sistem informasi geografis yang dilakukan
oleh Tropenbos International Indonesia Program (TBI_Indonesia) sebagai bagian
dari program peningkatan kapasitas sumber daya manusia di bidang kehutanan
untuk pemerintah baik di daerah maupun di pusat terkait dengan Sistem Informasi
Geografis (SIG).

ArcGIS merupakan software yang dikembangkan oleh ESRI. Software ini
merupakan software yang lebih integrated berbasis windows yang memiliki
kemampuan pada berbagai tingkatan. Pemanfaatan software ini ke depan
diharapkan semakin meningkatkan ketersediaan data dan informasi berbasis
keruangan dan mampu memberikan informasi yang lebih baik dan akurat kepada
pengguna data dan informasi kehutanan.

Dalam panduan ini, data geografis yang dipakai adalah dari Provinsi Riau.
Penggunaan data Provinsi Riau semata mata sebagai sebuah contoh. Untuk
pelatihan di tempat lain maka contoh data geografis dapat dipersiapkan sesuai
permintaan.

Kami mengucapkan terima kasih kepada berbagai pihak yang telah membantu
dalam penyusunan modul ini dan semoga modul ini dapat berguna bagi
peningkatan kapasitas pengguna dalam lebih memahami teknik sistem informasi
geografis.

Bogor, Desember 2010

DR. Petrus Gunarso
Direktur Program
TBI – Indonesia



 i

DAFTAR ISI

1. SISTEM INFORMASI GEOGRAFIS ......................................................................1

1.1. Pengertian Sistem Informasi Geografis (SIG) .................................... 1
1.2. Data Spasial ....................................................................................... 2

1.2.1. Format Data Spasial............................................................... 2
1.2.2 Sumber Data Spasial.............................................................. 4

2. PENGENALAN ArcGIS.......................................................................................5

2.1. ArcGIS sebagai Perangkat Lunak SIG yang Komprehensif .........................5

3. PENGENALAN ArcCATALOG .............................................................................9

3.1. Sekilas Tentang ArcCatalog ............................................................... 9
3.2. Browsing Data dengan ArcCatalog .................................................. 10
3.3. Menggunakan ArcCatalog ............................................................... 12

4. PENGENALAN ArcMAP ..................................................................................17

4.1. Membuka Data Spasial dengan ArcMap ......................................... 17
4.2. Melihat Data Atribut Sebuah Layer Menggunakan Map Tips dan

Hyperlink ......................................................................................... 19
4.3. Penyusunan Layer ........................................................................... 20
4.4. Mengaktifkan dan Menonaktifkan Layer ........................................ 21
4.5. Perbedaan View pada Data Anda.................................................... 22
4.6. Melihat Tampilan Peta .................................................................... 24
4.7. Melihat Atribut Data ....................................................................... 26
4.8. Pengelompokan Layer ..................................................................... 27
4.9. Merubah Tampilan Layer ................................................................ 28
4.10. Merubah Tampilan dengan Skala.................................................... 28

5 REKTIFIKASI...................................................................................................29

5.1. Pengertian Rektifikasi...................................................................... 29
5.2. Proses Rektifikasi............................................................................. 30

5.2.1. Menampilkan Tool Georeferencing .................................... 30
5.2.2. Menyiapkan Semua Layer Data Spasial............................... 31
5.2.3. Menyiapkan Layer Image .................................................... 31
5.2.4. Menambahkan Titik Kontrol................................................ 33
5.2.5. Menggunakan Tabel Data ................................................... 34
5.2.6. Rektifikasi Menggunakan Titik Kontrol dari GPS................. 34



i i

DAFTAR ISI

1. SISTEM INFORMASI GEOGRAFIS ......................................................................1

1.1. Pengertian Sistem Informasi Geografis (SIG) .................................... 1
1.2. Data Spasial ....................................................................................... 2

1.2.1. Format Data Spasial............................................................... 2
1.2.2 Sumber Data Spasial.............................................................. 4

2. PENGENALAN ArcGIS.......................................................................................5

2.1. ArcGIS sebagai Perangkat Lunak SIG yang Komprehensif .........................5

3. PENGENALAN ArcCATALOG .............................................................................9

3.1. Sekilas Tentang ArcCatalog ............................................................... 9
3.2. Browsing Data dengan ArcCatalog .................................................. 10
3.3. Menggunakan ArcCatalog ............................................................... 12

4. PENGENALAN ArcMAP ..................................................................................17

4.1. Membuka Data Spasial dengan ArcMap ......................................... 17
4.2. Melihat Data Atribut Sebuah Layer Menggunakan Map Tips dan

Hyperlink ......................................................................................... 19
4.3. Penyusunan Layer ........................................................................... 20
4.4. Mengaktifkan dan Menonaktifkan Layer ........................................ 21
4.5. Perbedaan View pada Data Anda.................................................... 22
4.6. Melihat Tampilan Peta .................................................................... 24
4.7. Melihat Atribut Data ....................................................................... 26
4.8. Pengelompokan Layer ..................................................................... 27
4.9. Merubah Tampilan Layer ................................................................ 28
4.10. Merubah Tampilan dengan Skala.................................................... 28

5 REKTIFIKASI...................................................................................................29

5.1. Pengertian Rektifikasi...................................................................... 29
5.2. Proses Rektifikasi............................................................................. 30

5.2.1. Menampilkan Tool Georeferencing .................................... 30
5.2.2. Menyiapkan Semua Layer Data Spasial............................... 31
5.2.3. Menyiapkan Layer Image .................................................... 31
5.2.4. Menambahkan Titik Kontrol................................................ 33
5.2.5. Menggunakan Tabel Data ................................................... 34
5.2.6. Rektifikasi Menggunakan Titik Kontrol dari GPS................. 34



ii ii 

5.2.7. Proses Pengaturan............................................................... 34
5.2.8. Menyimpan Hasil Rektifikasi ............................................... 35
5.2.9. Menampilkan Hasil Rektifikasi ............................................ 36

6 MEMBUAT DATA SPASIAL .............................................................................37

6.1. Pengertian Digitasi Peta .................................................................. 37
6.2. Metode Digitasi ............................................................................... 37

6.2.1. Menambah Data Gambar.................................................... 37
6.2.2. Membuat Layer atau Shapefile ........................................... 37
6.2.3. Menentukan Sistem Koordinat Shapefile............................ 39
6.2.4. Digitasi ................................................................................. 42
6.2.5. Snapping .............................................................................. 42
6.2.6. Memulai Digitasi.................................................................. 43
6.2.7. Menyimpan Hasil Digitasi .................................................... 45

7 EDITING DATA SPASIAL DAN ATRIBUT ...........................................................47

7.1. Editing Data Atribute....................................................................... 47
7.2. Editing Data Grafis........................................................................... 48

7.2.1. Membuat Objek Point atau Vertex dengan Koordinat ....... 48
7.2.2. Memotong Polygon Menjadi Dua Bagian ........................... 48
7.2.3. Merge Objek........................................................................ 49
7.2.4. Memotong Polygon dengan Polygon Lain........................... 50
7.2.5. Intersect Objek .................................................................... 51
7.2.6. Membuat Multipart Line atau Polygon............................... 52
7.2.7. Reshaping Polygon atau Line............................................... 54
7.2.8. Split Line .............................................................................. 54
7.2.9. Memotong Garis dengan Batas Garis.................................. 55
7.2.10. Menambah Panjang Garis (Extend)..................................... 56

7.3. Spatial Adjustment .......................................................................... 56
7.3.1. Transformasi........................................................................ 57
7.3.2. Rubber Sheeting .................................................................. 59
7.3.3. Edgematching ...................................................................... 61

8 TOPOLOGY GEODATABASE............................................................................63

8.1. Menyiapkan Geodatabase............................................................... 63
8.1.1. Membuat Tema atau Feature Dataset di ArcCatalog ......... 63
8.1.2. Membuat Feature Class ...................................................... 67
8.1.3. Memasukan data shape file ke database yang telah dibuat

............................................................................. 69



iii iii

8.2. Membangun Topology pada Geodatabase ..................................... 71
8.2.1. Kesalahan Topology............................................................. 71
8.2.2. Bekerja Dengan Topology.................................................... 73

8.3. Editing Topology pada ArcMap ....................................................... 76

9 QUERY DATA.................................................................................................79

9.1. Bekerja dengan Data Atribut........................................................... 79
9.1.1. Membuka Tabel Atribut ...................................................... 79
9.1.2. Mengatur Ulang Kolom ....................................................... 79
9.1.3. Setting Tampilan Tabel ........................................................ 81
9.1.4. Pemilihan Record................................................................. 83
9.1.5. Loading Data Atribut Eksternal ........................................... 84
9.1.6. Menggabungkan Tabel Atribut............................................ 84

9.2. Analisa Query dalam Data Atribut................................................... 86
9.2.1. Mencari Obyek Tertentu ..................................................... 86
9.2.2. Mengkalkulasi Statistik Obyek............................................. 87
9.2.3. Memilih Obyek secara Interaktif menggunakan Pernyataan

SQL....................................................................................... 88
9.3. Memanipulasi Data Atribut ............................................................. 89

9.3.1. Menambah Kolom............................................................... 89
9.3.2. Melakukan Persamaan Matematis...................................... 89

9.4. Menganalisa Data Atribut melalui Obyek Grafik............................. 90
9.4.1. Membuat Grafik Baru.......................................................... 90

10 SPATIAL ANALYST (ArcToolbox).....................................................................93

10.1. Extract.............................................................................................. 94
10.1.1. Clip ....................................................................................... 94
10.1.2. Select ................................................................................... 95
10.1.3. Split ...................................................................................... 95
10.1.4. Table Select ......................................................................... 96

10.2. Overlay............................................................................................. 96
10.2.1. Erase .................................................................................... 96
10.2.2. Identity ................................................................................ 99
10.2.3. Intersect............................................................................. 102
10.2.4. Symmetrical Difference..................................................... 103
10.2.5. Union ................................................................................. 104
10.2.6. Update ............................................................................... 105

10.3. Proximity........................................................................................ 106
10.3.1. Buffer ................................................................................. 106



iv iv

10.3.2. Multiple Ring Buffer .......................................................... 108
10.3.3. Near (menghitung jarak terdekat) .................................... 109
10.3.4. Point Distance.................................................................... 110

11 LAYOUT PETA ..............................................................................................111

11.1. Pengaturan Layout ........................................................................ 111
11.1.1. Menampilkan atau Mengatur Peta ................................... 111
11.1.2. Mengatur Proyeksi ............................................................ 112
11.1.3. Mengatur Halaman Layout................................................ 112

11.2. Penambahan Unsur unsur Peta .................................................... 114
11.2.1. Menambahkan Koordinat Peta ......................................... 114
11.2.2. Menambahkan Skala ......................................................... 117
11.2.3. Menambahkan Panah Penunjuk Arah............................... 118
11.2.4. Menambahkan Judul Peta................................................. 119
11.2.5. Menambahkan Object pada Layout .................................. 120
11.2.6. Menambahkan Teks pada Layout ..................................... 121
11.2.7. Membuat Extent Rectangle............................................... 123
11.2.8. Menambahkan Legenda.................................................... 124

11.3. Menyimpan Peta ........................................................................... 125
11.4. Ekspor Peta.................................................................................... 125
11.5. Mencetak Peta............................................................................... 126



1

 1 

1. SISTEM INFORMASI GEOGRAFIS

1.1 Pengertian Sistem Informasi Geografis (SIG)

Berikut ini, beberapa definisi SIG menurut para ahli:

1. Menurut Aronoff, 1989.
SIG adalah sistem informasi yang didasarkan pada kerja komputer yang
memasukkan, mengelola, memanipulasi dan menganalisa data serta
memberi uraian.

2. Menurut Burrough, 1986.
SIG merupakan alat yang bermanfaat untuk pengumpulan, penimbunan,
pengambilan kembali data yang diinginkan dan penayangan data
keruangan yang berasal dari kenyataan dunia.

3. Menurut Marble et al, 1983.
SIG merupakan sistem penanganan data keruangan.

4. Menurut Berry, 1988.
SIG merupakan sistem informasi, referensi internal, serta otomatisasi data
keruangan.

5. Menurut Calkin dan Tomlinson, 1984.
SIG merupakan sistem komputerisasi data yang penting.

Secara umum pengertian SIG sebagai berikut: ” Suatu komponen yang terdiri
dari perangkat keras, perangkat lunak, data geografis dan sumberdaya manusia yang
bekerja bersama secara efektif untuk memasukan, menyimpan, memperbaiki,
memperbaharui, mengelola, memanipulasi, mengintegrasikan, menganalisa dan
menampilkandata dalam suatu informasi berbasis geografis ”.

Menurut John E. Harmon, Steven J. Anderson. 2003, secara rinci SIG tersebut
dapat beroperasi dengan komponen komponen sebagai berikut:

1. Orang : yang menjalankan sistem

2. Aplikasi : prosedur yang digunakan untuk mengolah data

3. Data : informasi yang dibutuhkan dan diolah dalam aplikasi

4. Software : perangkat lunak SIG berupa program program aplikasi

5. Hardware : perangkat keras yang dibutuhkan untuk menjalankan sistem
berupa perangkat komputer, printer, scanner dan perangkat pendukung
lainnya.

Dalam pembahasan selanjutnya, SIG akan selalu diasosiasikan dengan
sistem yang berbasis komputer, walaupun pada dasarnya SIG dapat dikerjakan
secara manual, SIG yang berbasis komputer akan sangat membantu ketika data
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geografis merupakan data yang besar (dalam jumlah dan ukuran) dan terdiri dari
banyak tema yang saling berkaitan.

SIG mempunyai kemampuan untuk menghubungkan berbagai data pada suatu
titik tertentu di bumi, menggabungkannya, menganalisa dan akhirnya memetakan
hasilnya. Data yang akan diolah pada SIG merupakan data spasial yaitu sebuah data
yang berorientasi geografis dan merupakan lokasi yang memiliki sistem koordinat
tertentu, sebagai dasar referensinya. Sehingga aplikasi SIG dapat menjawab beberapa
pertanyaan seperti; lokasi, kondisi, trend, pola dan pemodelan. Kemampuan inilah
yang membedakan SIG dari sistem informasi lainnya.

Telah dijelaskan diawal bahwa SIG adalah suatu kesatuan sistem yang
terdiri dari berbagai komponen, tidak hanya perangkat keras komputer beserta
dengan perangkat lunaknya saja akan tetapi harus tersedia data geografis yang
benar dan sumberdaya manusia untuk melaksanakan perannya dalam
memformulasikan dan menganalisa persoalan yang menentukan keberhasilan SIG.

1.2 Data Spasial

Sebagian besar data yang akan ditangani dalam SIG merupakan data spasial
yaitu sebuah data yang berorientasi geografis, memiliki sistem koordinat tertentu
sebagai dasar referensinya dan mempunyai dua bagian penting yang membuatnya
berbeda dari data lain, yaitu informasi lokasi (spasial) dan informasi deskriptif
(attribute) yang dijelaskan berikut ini:

1. Informasi lokasi (spasial), berkaitan dengan suatu koordinat baik koordinat
geografi (lintang dan bujur) dan koordinat XYZ, termasuk diantaranya
informasi datum dan proyeksi.

2. Informasi deskriptif (atribut) atau informasi non spasial, suatu lokasi yang
memiliki beberapa keterangan yang berkaitan dengannya, contohnya: jenis
vegetasi, populasi, luasan, kode pos, dan sebagainya.

1.2.1 Format Data Spasial

Secara sederhana format dalam bahasa komputer berarti bentuk dan kode
penyimpanan data yang berbeda antara file satu dengan lainnya. Dalam SIG, data
spasial dapat direpresentasikan dalam dua format, yaitu:

a) Data Raster

Data raster (atau disebut juga dengan sel grid) adalah data yang dihasilkan dari
sistem Penginderaan Jauh. Pada data raster, obyek geografis direpresentasikan sebagai
struktur sel grid yang disebut dengan pixel (picture element).
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Pada data raster, resolusi (definisi visual) tergantung pada ukuran pixel
nya. Dengan kata lain, resolusi pixel menggambarkan ukuran sebenarnya di
permukaan bumi yang diwakili oleh setiap pixel pada citra. Semakin kecil ukuran
permukaan bumi yang direpresentasikan oleh satu sel, semakin tinggi resolusinya. Data
raster sangat baik untuk merepresentasikan batas batas yang berubah secara gradual,
seperti jenis tanah, kelembaban tanah, vegetasi, suhu tanah dan sebagainya.
Keterbatasan utama dari data raster adalah besarnya ukuran file; semakin tinggi
resolusi grid nya semakin besar pula ukuran filenya dan sangat tergantung pada
kapasistas perangkat keras yang tersedia.

b) Data Vektor

Data vektor merupakan bentuk bumi yang direpresentasikan ke dalam
kumpulan garis, area (daerah yang dibatasi oleh garis yang berawal dan berakhir pada
titik yang sama), titik dan nodes (merupakan titik perpotongan antara dua buah garis).

Keuntungan utama dari format data vektor adalah ketepatan dalam
merepresentasikan fitur titik, batasan dan garis lurus. Hal ini sangat berguna untuk
analisa yang membutuhkan ketepatan posisi, misalnya pada basisdata batas batas
kadaster. Contoh penggunaan lainnya adalah untuk mendefinisikan hubungan
spasial dari beberapa fitur. Kelemahan data vektor yang utama adalah
ketidakmampuannya dalam mengakomodasi perubahan gradual.
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Masing masing format data mempunyai kelebihan dan kekurangan.
Pemilihan format data yang digunakan sangat tergantung pada tujuan
penggunaan, data yang tersedia, volume data yang dihasilkan, ketelitian yang
diinginkan, serta kemudahan dalam analisa. Data vektor relatif lebih ekonomis
dalam hal ukuran file dan presisi dalam lokasi, tetapi sangat sulit untuk digunakan
dalam komputasi matematik. Sedangkan data raster biasanya membutuhkan ruang
penyimpanan file yang lebih besar dan presisi lokasinya lebih rendah, tetapi lebih
mudah digunakan secara matematis.

1.2.2 Sumber Data Spasial

Salah satu syarat SIG adalah data spasial, yang dapat diperoleh dari beberapa
sumber antara lain:

a) Peta Analog

Peta analog (antara lain peta topografi, peta tanah dan sebagainya) yaitu peta
dalam bentuk cetak. Pada umumnya peta analog dibuat dengan teknik kartografi,
kemungkinan besar memiliki referensi spasial seperti koordinat, skala, arah mata angin
dan sebagainya.

Dalam tahapan SIG sebagai keperluan sumber data, peta analog dikonversi
menjadi peta digital dengan cara format raster diubah menjadi format vektor
melalui proses digitasi sehingga dapat menunjukan koordinat sebenarnya di
permukaan bumi.

b) Data Sistem Penginderaan Jauh

Data Penginderaan Jauh (antara lain citra satelit, foto udara dan sebagainya),
merupakan sumber data yang terpenting bagi SIG karena ketersediaanya secara
berkala dan mencakup area tertentu. Dengan adanya bermacam macam satelit di
ruang angkasa dengan spesifikasinya masing masing, kita bisa memperoleh berbagai
jenis citra satelit untuk beragam tujuan pemakaian. Data ini biasanya direpresentasikan
dalam format raster.

c) Data Hasil Pengukuran Lapangan

Data pengukuran lapangan yang dihasilkan berdasarkan teknik perhitungan
tersendiri, pada umumnya data ini merupakan sumber data atribut contohnya: batas
administrasi, batas kepemilikan lahan, batas persil, batas hak pengusahaan hutan dan
lain lain.

d) Data GPS (Global Positioning System)

Teknologi GPS memberikan terobosan penting dalam menyediakan data
bagi SIG. Keakuratan pengukuran GPS semakin tinggi dengan berkembangnya
teknologi satelit navigasi. Pengolahan data yang bersumber dari GPS biasanya
dilakukan dalam format vektor.
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2 PENGENALAN ArcGIS

Teknologi Sistem Informasi Geografi (SIG) telah banyak digunakan
manfaatnya untuk meningkatkan komunikasi dan kolaborasi dalam pengambilan
keputusan (decision making), pengelolaan aset aset dan sumberdaya secara efektif,
meningkatkan alur kerja secara efisien, serta digunakan dalam perbaiki akses suatu
informasi. SIG yang komprehensif mencakup berbagai penggunaan, antara lain
untuk kompilasi dataset geografis, pembuatan alur kerja dan kontrol kualitas
‘authoring’ peta dan model model analitik, serta untuk mendokumentasikan
metode metode kerja. SIG yang komprehensif akan menyediakan sarana atau media
yang lengkap untuk pengelolaan, visualisasi, serta sebagai sarana mengkomunikasikan
suatu fenomena yang dikaji.

2.1. ArcGIS Sebagai Perangkat Lunak SIG yang Komprehensif

ArcGIS menyediakan kerangka yang scalable dapat disesuaikan menurut
keperluan, yang mampu diimplementasikan untuk single users maupun multiusers
dalam aplikasi desktop, server, dan internet (Web). ArcGIS 9.x merupakan
kumpulan produk produk perangkat lunak SIG yang dapat digunakan untuk
membangun suatu aplikasi SIG yang lengkap. ArcGIS 9.x terdiri dari empat kerangka
utama:

• ArcGIS Desktop – Merupakan integrasi dari sederetan aplikasi aplikasi SIG
yang terdiri dari tiga produk perangkat lunak utama yang dibedakan

menurut level kemampuannya: ArcView®, ArcEditorTM, dan ArcInfo®.

• Server GIS – Merupakan kumpulan aplikasi ArcGIS yang berbasiskan server
yang digunakan untuk membangun suatu sistem lintas departemen yang
terintegrasi untuk koleksi, organisasi, visualisasi, pengelolaan, serta
pendistribusian informasi geografis. Aplikasi ArcGIS berbasis server terdiri dari tiga
produk: ArcIMS, ArcGIS Server, dan ArcGIS Image Server.
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• ESRI Developer Network (EDNSM) – Merupakan perangkat lunak yang
menyediakan sistem yang lengkap untuk membangun aplikasi menggunakan
ArcGIS. Inti daripada EDN Developer Kit adalah ArcObjects, yaitu suatu library
dari berbagai komponen komponen perangkat lunak yang dapat digunakan
untuk membangun suatu aplikasi.

• Mobile GIS – Merupakan aplikasi ArcGIS yang difokuskan untuk keperluan

mobile device, antara lain: ArcPad, ArcGIS Mobile.
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2.2. ArcGIS Desktop

ArcGIS Desktop merupakan platform dasar yang dapat digunakan untuk mengelola
suatu proyek dan alur kerja SIG yang komplek serta dapat digunakan untuk
membangun data, peta, model, serta aplikasi. ArcGIS Desktop mencakup
ArcCatalog, ArcMap, ArcToolbox, ArcGlobe, dan ModelBuilder. Dengan
menggunakan aplikasi ini pengguna dapat menjalankan berbagai macam proses
SIG dari yang paling simpel hingga tingkat lanjut.

• ArcCatalog – digunakan untuk mengorganisasikan dan mengelola semua
informasi geografis, seperti peta, data data format file, geodatabases,
toolboxes untuk geoprosesing, metadata, serta services SIG.

• ArcMap – merupakan aplikasi utama dalam ArcGIS, yang dapat
digunakan untuk mapping dan editing, serta untuk query dan analisa yang
berdasarkan pada peta.

• ArcToolbox – merupakan koleksi dari tools geoprosesing

• ArcGlobe – Aplikasi ArcGlobe tercakup dalam ekstensi ArcGIS 3D Analyst,
yang mempunyai kemampuan untuk penayangan informasi geografis
dalam bentuk kenampakan 3D yang dinamis.

• ModelBuilder – merupakan bahasa pemrograman secara visual yang
digunakan untuk membangun suatu alur kerja dan skrip dari suatu
rangkaian geoprosesing.
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ArcGIS Desktop menyediakan aplikasi yang scalable yang dapat disesuaikan
dengan kemampuan dan kebutuhan penggunanya, berdasarkan level
fungsionalitasnya dapat dibedakanmenjadi:

• ArcView – fokus pada penggunaan data, mapping, analisa, visualisasi, serta
simpel editing dan geoprocessing.

• ArcEditor – mempunyai kemampuan untuk editing tingkat lanjut untuk data
shapefiles dan geodatabase sebagai tambahan dari fungsionalitas ArcView.

• ArcInfo – mempunyai fungsionalitas terlengkap, mencakup fungsi fungsi yang
tersedia pada ArcView dan ArcEditor serta kemampuan geoprosesing tingkat
lanjut.

2.3. Model Data Geografis dan Format Data Dalam ArcGIS

Penyimpan dan pengelolaan data geografis pada perangkat lunak ArcGIS dapat
dilakukan dalam berbagai format. Terdapat beberapa model data yang digunakan
dalam ArcGIS yaitu:

• Vektor – Dalam model data vektor tiap tiap lokasi atau posisi
disimpan sebagai satu koordinat x,y yang simpel. Titik (point) disimpan
sebagai koordinat tunggal. Garis (line) disimpan sebagai suatu rangkaian
koordinat x,y. Polygon (area) disimpan sebagai rangkaian koordinat x,y
yang mendefinisikan suatu segmen garis hingga menjadi suatu area
yang tertutup.

 Raster – Merupakan struktur data yang terdiri dari sel sel (cellular/pixel)
yang tersusun dari

baris dan kolom untuk menyimpan suatu gambar (image). Masing masing
sel atau piksel menyimpan sebuah nilai tertentu.
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3 PENGENALAN ArcCATALOG

3.1 Sekilas Tentang ArcCatalog

ArcCatalog adalah salah satu modul dari ArcGIS yang bisa digunakan
antara lain untuk :

1. menelusuri/mencari data (browsing)

2. mengorganisir (organizing)

3. membagi bagikan (distributing)

4. dan mendokumentasikan (documenting) suatu struktur data dalam ArcGIS.

ArcCatalog menyediakan beberapa fungsi antara lain untuk menampilkan
(preview), membuat dokumen dan mengatur data geografis serta membuat
geodatabase untuk menyimpan data spasial dan tabular. ArcCatalog merupakan
sebuah fasilitas untuk mengatur data dalam jumlah besar yang disimpan tersebar
dalam folder data GIS. Tampilan (views) data di dalam ArcCatalog sangat membantu
Pengguna untuk secara cepat mencari data yang Pengguna perlukan walaupun
tersimpan dalam sebuah file, personal geodatabase dan ArcSDE geodatabase dalam
jaringan RDBMS.

Dalam ArcCatalog pengguna dapat mengatur/mengelola folder dan file file
data ketika membuat project database di dalam computer. Pengguna juga dapat
membuat personal geodatabase pada komputer dan membuat atau meng import
feature class dan tabel. Dengan ArcCatalog pengguna juga dapat membuat,
menampilkan dan merevisi metadata, mendokumentasikan dataset dan juga project
yang telah dibuat.

Langkah langkah memulai ArcCatalog adalah sebagai berikut :

1. Klik Start > Program > ArcGIS > ArcCatalog

2. Pada saat Pengguna menjalankan ArcCatalog, Pengguna akan melihat ada
dua buah panel, seperti terlihat pada gambar dibawah ini :
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3.2 Browsing Data dengan ArcCatalog

Fungsi dari ArcCatalog adalah untuk browsing data. Pembuatan shortcut
juga tersedia dalam ArcCatalog agar Pengguna dapat mengakses data dengan mudah.
Cara untuk mengakses data dalam ArcCatalog adalah sebagai berikut:

1. Klik pada “File” > Connect Folder
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2. Kemudian carilah folder data yang akan Pengguna akses :

3. Setelah Pengguna mendapatkan data yang dimaksud, selanjutnya akan
Pengguna dapatkan katalog yang menujukkan turunan dari data tersebut
dan Pengguna juga dapat langsung menggunakan data.
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3.3 Menggunakan ArcCatalog

1. Pilihlah folder data yang ingin diakses, contohnya D:\TBI GIS
Training\Vector\Administrasi Pengguna akan melihat ada beberapa
perbedaan simbol yang terdapat di dalam ArcCatalog seperti dibawah ini:

2. Pengguna dapat menampilkan atau menyembunyikan ekstensi data yang
ada, dari Menu utama pilihlah Tools > Options, kemudian pilih General.
Hilangkan pengguna/pilihan pada “Hide file extensions” dan klik OK.

3. Pengguna bisa mengakses data dan informasi melalui Table of Contents.
Informasi yang ditampilkan merupakan penjelasan atau uraian singkat dari
data tersebut.

4. Pengguna juga dapat mengganti tabulasi yang ada untuk dapat melihat
data tersebut dengan beberapa cara yaitu dalam bentuk gambar maupun
dalam bentuk tabel.
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5. Pada Tab Preview Pengguna dapat menampilkan data dalam bentuk
tabular maupun dalam bentuk gambar, jika Pengguna mengubah pilihan
pada Table maka ArcCatalog akan menampilkan data dalam bentuk tabel
sedangkan apabila Pengguna mengubahnya menjadi pilihan Geography
maka data akan ditampilkan data dalam bentuk gambar berikut.
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6. Pada Options terdapat beberapa menu pilihan seperti mencari, membuat
file, mengatur, serta mengekspor data menjadi file dengan ekstensi DBF.
Melalui tool ini Pengguna juga bisa mencari data di dalam tabel secara
berurutan maupun satu persatu, serta dapat mengurutkan data sesuai
dengan keinginan Pengguna serta menyimpannya dalam format tabel.

7. Salah satu keunggulan ArcCatalog adalah karena tersedianya Metadata.
Metadata adalah data yang menerangkan tentang data yang Pengguna
maksud seperti informasi sumber data dan status data (apakah masih
dalam proses atau sudah selesai finished).

Pada pilihan Metadata Pengguna akan menemukan beberapa informasi yang
lebih detail tentang data yang Pengguna maksud dan juga dalam beberapa
format yang telah disediakan oleh ArcCatalog, sehingga Pengguna dapat
menambah atau mengurangi informasi tentang data tersebut. ArcCatalog
menyediakan beberapa format data, diantaranya adalah:
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a. FGDC (Federal Geographic Data Commitee),

b. FGDC Classic,

c. FGDC ESRI,

d. FGDC FAQ,

e. FGDC Geography Network,
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4 PENGENALAN ArcMAP

4.1 Membuka Data Spasial dengan ArcMap

1. Klik Start > Programs > ArcGIS > ArcMap atau double klik icon ArcMap pada
desktop.

2. Terlihat kotak dialog Startup yang akan memberikan pilihan untuk memulai
sebuah sesi pekerjaan. Pengguna dapat memilih antara lain:

membuka Project baru (open new map), membuka format yang telah
disediakan (template), atau membuka sebuah Project document yang telah
ada atau Project yang telah dibuat sebelumnya.

3. Pilih An Existing Map, kemudian klik di Browse for Maps untuk melihat
Project document yang telah ada lanjutkan dengan klik OK.
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4. Arahkan pada directory d:\TBI GIS Training\Workspace dan pilih file Project
dengan nama PetaAdministrasiRiau

5. Peta Indonesia akan tampil di layar. Perhatikan bahwa layar ArcMap akan
menampilkan dua bagian, yaitu:

a. Window Table Of Contents (TOC), di bagian kiri layar yang berisi
informasi tentang layer.

b. Window Data Frame, di bagian kanan layar yang menunjukkan
Tampilan Peta
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6. Selanjutnya kita akan melihat serangkaian dataset (shapefile atau image)

4.2 Melihat Data Atribut Sebuah Layer Menggunakan Map Tips dan Hyperlink

1. Pada toolbar Tools klik Select Elements

2. Sekarang, gerakan kursor ke arah salah satu bagian di peta. Perhatikan,
bahwa ArcMap akan menampilkan nama Propinsi. Nama ini adalah data
atribut yang tersimpan di layer Indonesia_polygon.

3. Pada window Table of Contents, aktifkan tampilan layer berikut ini dengan
klik tiap layer:

a. Kota Provnas_font_point

b. Negara_polygon

c. Indonesia_polygon

d. Bps_riau_district2003

e. Laut Nas 1_region

f. tbi_riauproject_esri_srtm.img

Data FrameTable of
Contents
Table of 
Contents

Data Frame
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4. Geser kursor di atas point Kota pada peta. Perhatikan, ArcMap akan
menampilkan nama kota. Data atribut dalam layer kota akan ditampilkan
melalui Map Tips.

5. Untuk memperjelas data nama kota , kita harus melakukan perbesaran
dengan men zoom (Zoom in) pada data frame. Pada toolbar Tools klik
Zoom In dan klik pada peta untuk memperbesar tampilan peta.

6. Kita dapat menggeser peta dengan menggunakan Pan. Klik Pan lalu
pindahkan kursor ke arah peta kemudian klik tahan dan geser peta.

7. Perhatikan, pada saat kita memperbesar peta, maka nama kota akan
muncul. Data atribut ini ditampilkan sebagai label, dan hanya dapat terlihat
pada skala yang sudah ditetapkan. ArcMap memiliki kemampuan untuk
mengatur tampilan layer pada skala yang ditetapkan dan berpengaruh
pada keakuratan data spasial dengan skala tertentu. Sebagai contoh
beberapa feature tidak dapat diberi label secara tepat pada perbesaran
yang terlalu kecil.

8. Apabila ada keterangan feature yang tidak muncul, klik kanan pada layer,
properties, pada tab display checklis show map tips. Show map tips baru
dapat digunakan apabila layer tersebut mempunyai index (ArcCatalog).

9. Hyperlink, Klik kanan bps_riau_district2003, properties, pada tab Display
checklist Support Hyperlinks using field dan pilih field yang digunakan.
Untuk melihat Hyperlink, gunakan tool Hyperlink dan klik pada feature
yang mempunyai hyperlink.

4.3 Penyusunan Layer

1. Pada toolbar Tools klik Full Extent.

2. Klik pada window Table of Contents dan aktifkan layer
bps_riau_district2003. Layer ini menampilkan gradasi warna yang
menunjukkan poligon sebaran kabupaten. Untuk melihat nilainya, klik
simbol expand untuk layer.
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3. Layer ini dibuat dari layer propinsi. Perhatikan, semua data spasialnya
adalah sama. Beberapa data atribut telah digunakan untuk membuat peta
tematik, layer ini adalah poligon wilayah administrasi kabupaten/kota.

4. Sekarang, kita akan melihat bagaimana cara menyusun layer dalam SIG.
Pada window Table of Contents klik layer untuk bps_riau_district2003,
kemudian klik tahan (drag) dan pindahkan layer itu sehingga berada di atas
layer Indonesia_polygon.

5. Klik tahan layer bps_riau_district2003 ke bagian atas window Table of
Contents dan perhatikan bagaimana perubahan tampilan layer Inset.

6. Klik kotak tampilan layer bps_riau_district2003. Akan tampil gambar yang
memperlihatkan poligon sebaran kabupaten di Propinsi Riau.

4.4 Mengaktifkan dan Menonaktifkan Layer

Layer dapat diaktifkan dan dinonaktifkan, kita hanya dapat bekerja pada layer
yang aktif pada ArcMap. Langkah langkahnya sebagai berikut :

1. Non aktifkan layer bps_riau_district2003.
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2. Non aktifkan semua layer kecuali layer image atau layer yang berekstensi
*.img, yaitu salah satu tipe data berbeda yang digunakan dalam SIG. Tipe
data ini dikenal sebagai data raster, atau data image. Klik Full Extent untuk
menampilkan seluruh image.

3. Perhatikan bahwa image berisi banyak informasi. Kita dapat menggunakan
image untuk mendapatkan lebih banyak informasi dibandingkan dengan
data vektor. Kita bisa memperoleh berbagai variasi data seperti tinggi
tempat di Propinsi Riau menggunakan image akan tetapi kita juga
membutuhkan data vektor untuk mengetahui dimana lokasi daerah
tersebut.

4. Perbesar (zoom in) hanya pada daerah Riau. Pada skala ini kita dapat
melihat keterbatasan sebuah data raster (image).

5. Data raster maupun data vektor tidak cukup detil untuk digunakan pada
skala tertentu yang memiliki keterbatasan pada skala tertentu.

6. Klik File menu dan pilih exit. Akan muncul kotak dialog yang berisi
pertanyaan apakah kita mau menyimpan perubahan pada dokumen. Pilih
No.

4.5 Perbedaan View pada Data Anda

ArcMap adalah bagian dari aplikasi ArcGIS untuk menampilkan data spasial dan
melakukan operasi – operasi reporting query, edit, komposisi dan mempublikasikan
peta. Sebagian besar pengerjaan produk yang anda hasilkan hanya visual, anda akan
banyak mengunakan ArcMap dibandingkan dengan beberapa aplikasi ArcGIS yang lain.

Kita akan mulai melihat perbedaan view data dalam ArcMap. View adalah
window yang akan paling sering digunakan dibandingkan window lainnya di ArcGIS.
Langkah langkah pengoperasian ArcMap sebagai berikut:
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1. Klik tombol Start > Program > ArcGIS > ArcMap atau dengan mengklik icon
ArcMap pada layar desktop anda.

2. Dari Startup dialog box pilih An Existing Map, pilih Browser for Maps dan
klik OK

3. Pastikan anda memilih Arcmap document dan kemudian pilih document
PetaAdministrasiRiau.mxd

4. Peta akan menampilkan Indonesia dan Propinsi Riau. Sekarang perhatikan
peta pada data view.

5. Dua data frame dalam map dokumen tersebut – dapat diperhatikan pada
list Tabel of content. Perhatikan Inset Data Frame – frame yang aktif akan
berwarna hitam tebal.

6. Data data frame ini akan muncul pada tabel of content layar monitor anda.

7. Untuk mengaktifkan layer klik kanan pada layer tersebut, misalkan pada
layer Detail Data Frame. Sebuah menu box akan muncul. Pilih Activate
maka pada layar monitor akan tampil Inset Data Frame sebuah peta Riau.

8. Pada Table of Content untuk map document yang terdapat 2 data frame,
keduanya memperlihatkan layer dan cover area yang berbeda. Perhatikan
data yang ditampilkannya. Sebagai indikasi frame yang aktif adalah tulisan
tebal hitam.

9. Aktifkan kembali Inset Data Frame dengan mengunakan kursor klik kanan
pada Inset Data Frame dalam Table of Content, dari kotak menu pilih
Activate.

10. Kedua data frame dapat langsung dilihat pada layout view – ArcMap’s
desktop publishing environment.

11. Untuk melihat view yang berbeda hanya dengan mengklik view > layout
view atau tombol Layout View pada sudut kiri bawah ArcMap:

Data View Layout View
Data View Layout View
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12. ArcMap sekarang menampilkan frame yang sama seperti yang anda lihat
pada data view. Pada layout view yang terlihat akan sama dengan hasil
yang akan di print nantinya.

13. Pada data frame anotasi tidak tepat di atas feature tetapi berada di atas
data frame saja.

14. Klik tombol Data View, pada tombol kiri layout untuk kembail kemap view.

4.6 Melihat Tampilan Peta

Pada toolbar terdiri beberapa tombol untuk memanipulasi setting view. Pada
latihan sebelumnya anda telah mengoperasikan tombol tombol dasar (seperti zoom in,
zoom out dan pan).

1. Untuk mengetahui fungsi dari masing masing tombol dapat dilakukan
dengan langkah – langkah sebagai berikut:

a. Arahkan kursor ke tombol tersebut.

b. Keterangan dalam box kuning akan muncul.

c. Untuk mengetahui lebih jelas fungsi tombol tersebut perhatikan bar
abu abu pada bagian bawah layar monitor anda. Perhatikan gambar di
bawah ini:

Data Frames (map) AnnotationData Frames (map) Annotation
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2. Sekarang lihat setiap fungsi dari tombol pada toolbar navigation, dan coba
pahami bagaimana penggunaannya. Perlu diperhatikan juga bahwa tidak
semua tombol tersedia pada toolbar, untuk menemukannya adalah
dengan menggunakan tool tips. Berikut ini adalah fungsi dari tombol
toolbar Navigation:

Icon Nama Fungsi

Zoom in
untuk memperbesar tampilan view dengan mengklik pada daerah
yang akan diperbesar.

Zoom Out
untuk memperkecil tampilan view dengan mengklik pada daerah
yang akan diperkecil.

Fixed Zoom In untuk memperbesar tampilan view terhadap pusat view.

Fixed Zoom Out untuk memperkecil tampilan view terhadap pusat view.

Pan – Move
memindahkan dan menggeser peta atau tampilan dengan tidak
mengganti skala view.

Full Extents memperbesar seluruh tampilan peta atau view pada layar.

Go to Previous / Next
Extents

untuk kembali pada tampilan sebelumnya /
sesudahnya.

3. Sekarang buka kembali map view untuk menampilkan data view Propinsi
Riau. Untuk membuatnya anda dapat menggunakan pre defined bookmark

a

b

c

a

b

c
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yang telah di set up dalam map document. Klik menu view, pilih Bookmark
kemudian pilih Riau, peta akan menampilkan area Riau.

4.7 Melihat Atribut Data

Pada ArcMap untuk mengidentifikasi suatu data atribut dan sekaligus
komponen geografis pada setiap layer gunakan tombol identify atribut, berikut ini
adalah langkah – langkahnya:

1. Klik tombol Identify pada toolbar

2. Kemudian klik sebuah sebuah layer Kota point, dari hasil identify akan
muncul keterangan seperti kotak dialog dibawah ini:

3. Perhatikan atribut data pada kotak Identify Results yang akan
memperlihatkan semua field (kolom) yang ada dalam feature. Layer yang
anda pilih juga menampilkan nama layer feature nya termasuk semua
primary display field (semua kolom atribut utama) pada layer tersebut
dengan kata lain field (kolom atribut) yang digunakan dalam ArcMap
tergantung feature nya.

4. Untuk melihat informasi pada feature yang lain, jangan tutup Identify
Results dialog dan pilih feature lainnnya dengan cara mengklik feature dari
layer yang tersedia untuk melihat informasi yang terdapat di dalamnya.
Perhatikan pada setiap kasus, ArcMap akan kembali menampilkan semua
atribut informasi yang terdapat di dalam masing masing layer tersebut,
seperti yang terlihat data data pada primary display field.
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5. Pada beberapa kasus, apabila sebuah data tidak dapat teridentifikasi maka
akan muncul peringatan nothing found hal ini disebabkan oleh banyaknya
layer dalam feature pada saat mengklik tombol identify. Sebagai jalan
keluarnya adalah dengan klik kembali tombol indentify dan pilih kembali
feature feature yang lain dalam peta. Dari Identify Result dialog klik tanda
panah segi tiga dan pilih layer bps_riau_district2003 data yang akan
ditampilkan hanya pada atribut layer yang dipilih tersebut.

6. Pada peta klik daerah sekitar bps_riau_district2003 feature. Perhatikan,
jika anda mengklik pada feature yang lain maka atribut tidak
muncul dan saat kita klik kembali feature bps_riau_district2003,
Identify Result dialog akan menampilkan atribut datanya kembali.

7. Ulangi langkah langkah identify dengan setting layer option dalam Identify
Result dialog terhadap layer layer yang lain untuk dapat lebih
memahami kegunaannya. Pada bagian ini juga akan menolong kita untuk
lebih memahami bagaimana cara kerja layer layer dalam GIS.

4.8 Pengelompokan Layer

Untuk memudahkan proses analisa dan membuat suatu perencanaan data
spasial dilakukan pengelompokan layer atau grouping layers. Untuk membuat group
layer dapat dilihat pada gambar berikut:

1. Pada Table of Content, pilih data frame (layers) kemudian klik kanan mouse
maka akan muncul perintah seperti terlihat pada berikut ini. Pilih New
Group Layer untuk membuat kumpulan layer baru dan untuk mengganti
nama Group Layer dengan cara klik kanan kemudian pada tab General,
Layer Name isi dengan nama baru misalnya Basis data.

2. Setelah membuat group layer, tambahkan beberapa layer ke dalam group
tersebut, contohnya layer jalan dan layer transmigrasi ke dalam group
layer Basis data, caranya dengan melakukan seleksi kedua layer tersebut
dengan mouse kemudian geser ke bagian bawah group Basis data dan
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lepas tombol mouse, maka kedua layer tersebut akan berada dalam group
basis data.

4.9 Merubah Tampilan Layer

Pada ArcMap tersedia simbol default untuk membedakan setiap layer dengan
pengaturan pada setiap layer (warna dan simbol) kita dapat melihat perbedaan dan
menganalisa layer–layer tersebut. Langkah – langkahnya adalah sebagai berikut :

1. Pada layer jalan (layer line) klik kanan dan pilih Properties pilih tab
Symbology.

2. Setelah Tab Symbology di klik, kita dapat mengatur simbol dan warna.

3. Untuk melakukan setting simbol dan warna pada feature Point maupun
Polygon digunakan prosedur yang sama.

4.10 Merubah Tampilan dengan Skala

Pada Layer Properties kita dapat mengatur skala sehingga suatu layer dapat
ditampilkan dengan skala tertentu yang kita inginkan langkah–langkahnya adalah
sebagai berikut: Pada Layer Properties klik tab General dan terdapat dua option untuk
pengaturan visible pada layer. Option yang pertama layer ditampilkan untuk semua
skala dan option kedua layer ditampilkan pada interval skala tertentu, misalnya skala
maksimum 1000 dan skala minimum 5000.
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5 REKTIFIKASI

5.1 Pengertian Rektifikasi

Data raster yang biasanya diperoleh dari hasil scan peta, foto udara dan citra
satelit belum berisi informasi yang menunjukkan referensi spasial, baik yang tersimpan
di dalam file atau yang disimpan sebagai suatu file yang terpisah. Sehingga untuk
menggunakan beberapa data raster secara bersama dengan data spasial yang lain yang
sudah ada, diperlukan proses georeferencing ke dalam sebuah sistem koordinat yang
disebut koreksi geometrik.

Geometrik citra adalah korelasi antara koordinat suatu obyek (x,y) pada citra
dengan koordinat (X,Y) pada permukaan bumi. Koreksi geometrik diperlukan untuk
menghilangkan distorsi geometrik pada citra dan juga untuk mendapatkan hubungan
antara sistem koordinat citra (baris,kolom) dengan sistem koordinat proyeksi.
Koreksi ini adalah merupakan proses mentransformasi koordinat titik titik pada citra
yang masih mengandung kesalahan geometrik menjadi citra yang benar.

Dalam pekerjaan koreksi geometrik, terdapat satu tahap yang dikenal
dengan nama rektifikasi. Rektifikasi adalah suatu proses pekerjaan untuk
memproyeksikan citra yang ada ke bidang datar dan menjadikan bentuk konform
(sebangun) dengan sistem proyeksi peta yang digunakan, juga terkadang
mengorientasikan citra sehingga mempunyai arah yang benar (Erdas, 1991).

Untuk keperluan rektifikasi citra satelit, dibutuhkan beberapa koordinat titik
kontrol lapangan sebagai bagian dari titik sekutu. Koordinat titik kontrol lapangan ini
dapat diperoleh dari pengukuran langsung di lapangan dengan GPS atau interpolasi
dari peta dasar yang sudah ada.

Banyaknya titik kontrol yang harus anda buat tergantung pada kompleksitas
dari bentuk transformasi polynomial yang rencananya akan anda gunakan untuk
mengubah dataset raster ke dalam koordinat peta. Untuk hasil rektifikasi yang baik,
anda harus menyebarkan secara merata titik kontrol dibandingkan dengan hanya
memusatkannya dalam satu area.

Ada beberapa alasan untuk melakukan rektifikasi, antara lain :

1. Untuk perbandingan sebuah pixel dalam beberapa aplikasi seperti
perubahan yang terjadi atau pemetaan kelembaman panas (perbandingan
citra yang diambil pada siang dan malam hari)

2. Untuk membangun basis data sebuah pemodelan SIG

3. Untuk identifikasi sampel yang mengacu pada koordinat peta

4. Untuk membuat peta foto yang berskala tepat

5. Untuk keperluan tumpang susun (overlay) sebuah citra dengan data vektor
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6. Untuk membandingan sebuah citra dalam berbagai skala

7. Untuk meningkatkan ketepatan hitungan jarak dan luas pada citra

8. Untuk membuat mosaik citra

9. Berbagai aplikasi lain yang membutuhkan identifikasi sebuah lokasi
geografis secara teliti.

Parameter tingkat keakurasian dari proses rektifikasi ini adalah nilai yang
dipresentasikan oleh selisih antara koordinat titik kontrol hasil transformasi dengan
koordinat titik kontrol, yang dikenal dengan nama RMS (Root Mean Square) Error.
Nilai RMS Error yang rendah akan menghasilkan hasil rektifikasi yang akurat.
Sebagai contoh, hasil transformasi boleh jadi masih berisi kesalahan yang significant
karena rendahnya/sedikitnya titik control yang dimasukkan.

Ada beberapa faktor yang mempengaruhi RMS Error ini yaitu :

1. Tingkat ketelitian titik kontrol lapangan

2. Tingkat ketelitian titik kontrol citra

3. Jumlah dan distribusi letak titik control

4. Model transformasi yang digunakan

5.2 Proses Rektifikasi

Rektifikasi merupakan proses transformasi data, dari data yang belum
mempunyai koordinat geografis menjadi data yang akan mempunyai koordinat
geografi (georeferensi). Data yang sudah direktifikasi selanjutnya dapat
ditumpangsusunkan atau di overlay kan dengan beberapa data lain yang sudah
terekftifikasi lebih dulu seperti data raster/image (foto udara, citra satelit atau peta
scan dengan data spasial) di dalam GIS. Proses rektifikasi dapat dilakukan dengan
langkah sebagai berikut:

5.2.1 Menampilkan Tool Georeferencing

Jalankan Program ArcMap. Klik Pada menu view,kemudian klik Toolbars,pilih
georeferencing.
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5.2.2 Menyiapkan Semua Layer Data Spasial

1. Tampilkan semua layer yang akan digunakan sebagai referensi
image/raster dan layer yang berisi data raster / image yang akan
direktifikasi.

2. Zoom sesuai dengan fokus area yang dibutuhkan yang akan diambil sebagai
titik referensi.

3. Untuk layer polygon sebaiknya dibuat transparan (hollow).

5.2.3 Menyiapkan Layer Image

1. Tambahkan data yang akan direktifikasi dengan cara File > Add Data > Peta
Penggunaan Lahan Kab Siak.jpg
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2. Pada saat image dan basis data ditampilkan bersamaan full extent,
maka ArcMap akan menampilkan area kosong atau suatu titik kecil yang
tidak jelas, hal ini disebabkan image dan data spasial tidak memiliki sistem
proyeksi yang sama. Untuk itu atur skala image agar sesuai dengan
tampilan basis data, yaitu dengan zoom pada layer basis data kemudian
gunakan Tool georeferencing > fit to display, maka image dan basis data
bisa ditampilkan secara bersamaan/overlay tapi image masih belum sesuai
atau sejajar dengan basis data.
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5.2.4 Menambahkan Titik Kontrol

Agar titik image tepat atau identik dengan titik titik kontrol yang terdapat basis
data, lakukanlah langkah langkah berikut ini :

1. Pada Toolbar georeferencing pilih (Add Control Points) untuk georeferensi
terhadap image.

5.2.5 Cara pengoperasiannya sebagai berikut:

2. Gunakan mouse, tekan tombol kiri pada titik yang anda ketahui pada
image, tanda silang akan ditinggalkan pada titik yang anda pilih.

3. Kemudian, tekan tombol kiri pada titik kontrol pada layer basis data, hal ini
akan memindahkan image yang selaras dengan titik kontrol.

4. Ulangi lagi tahapan diatas untuk 2 atau 3 titik kontrol lainya yang anda
ketahui.

5. Setelah mengulangi 2 atau 3 titik kontrol lainnya maka image akan terlihat
seperti pada gambar dibawah ini.
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5.2.6 Menggunakan Tabel Data

Untuk setiap set titik kontrol yang telah dibuat, masukan tabel yang berisi titik
titik koordinat awal, koordinat titik kontrol dan tingkat penyimpangan yang terjadi.
Untuk akses tabel ini pilih View Link Table pada Tool georeferencing.

Apabila terjadi salah pengisian koordinat, entri data pada table ini dapat
dihapus sekaligus secara bersamaan, sehingga memudahkan dalam melakukan koreksi.

5.2.7 Rektifikasi Menggunakan Titik Kontrol dari GPS

Bila anda ingin menggunakan titik titik referensi yang diperoleh di lapangan
dengan menggunakan GPS untuk merektifikasi citra satelit, sebagai alternatif dari
metode georeferensi yang telah dijelaskan diatas. Langkah langkah untuk melakukan
metode ini sama dengan metode rektifikasi menggunakan table data.

5.2.8 Proses Pengaturan

Tingkat penyimpangan adalah nilai yang menyatakan tingkat kecocokan antara
lokasi sebenarnya dengan lokasi transformasi sebagai Titik kontrol output. Jika tingkat
penyimpangan cukup tinggi sebaiknya hapus titik tersebut dari dalam tabel dan klik
Delete.

Jumlah titik kontrol tergantung pada kebutuhan, dari table georeferensi
anda bisa melakukan transformasi pertama, kedua, atau ketiga. Transformasi
membandingkan koordinat pada image dengan titik titik kontrol (minimal 3 atau 4
titik kontrol) untuk menyelaraskan koordinat image kedalam peta dasar (basis data).
Transformasi pertama (1st) akan memindahkan image ke atas, bawah, kiri atau kanan,
image akan tertarik lebih lebar atau lebih kecil, atau image terputar. Transformasi
kedua (2nd) dan ketiga (3rd) akan lebih menyelaraskan data secara polynomial,
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memungkinkan titik titik tersebut berpindah tidak selaras (be shifted in non uniform
manner).

5.2.9 Menyimpan Hasil Rektifikasi

Ada tiga pilihan untuk menyimpan hasil rektifikasi

1. Sebagai text file; anda bisa load text file bila ingin melakukan goereferensi
lagi terhadap image, dari Link table pilih Save.

2. Sebagai .aux file; ini akan menyimpan semua perubahan dan file ini bisa
dibaca oleh semua produk ESRI.

3. Sebagai World file; ini akan membuat image baru (TIFF, ESRI Grid, atau
ERDAS imagine) dengan menyimpan koordinat kootdinatnya. Gunakan
pilihan ini bila ingin menggunakan image untuk kepentingan GIS, dari Tool
georeferencing pilih Rectify.

Selanjutnya akan muncul kotak dialog Save As. Isilah nama output file hasil
rektifikasi Penggunaan_Lahan_Kab_Siak_rekt.img. Kemudian klik tombol Save untuk
menjalankan proses rektifikasi. Tunggu beberapa saat sampai proses rektifikasi selesai.
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5.2.10 Menampilkan Hasil Rektifikasi

Jalankan ArcMap. Tambahkan layer Penggunaan_Lahan_Kab_Siak_rekt.img
sehingga akan tampak seperti gambar di bawah ini.
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6 MEMBUAT DATA SPASIAL

6.1 Pengertian Digitasi Peta

Digitasi secara umum dapat didefinisikan sebagai proses konversi data analog
ke dalam format digital. Objek objek tertentu seperti jalan, rumah, sawah dan lain lain
yang sebelumnya dalam format raster Pada sebuah citra satelit resolusi tinggi dapat
diubah kedalam format digital dengan proses digitasi.

6.2 Metode Digitasi

Proses digitasi secara umum dibagi dalam dua macam:

1. Digitasi menggunakan digitizer

Dalam proses digitasi ini memerlukan sebuah meja digitasi atau digitizer.

2. Digitasi onscreen di layar monitor

Digitasi onscreen paling sering dilakukan karena lebih mudah dilakukan,
tidak memerlukan tambahan peralatan lainnya, dan lebih mudah untuk
dikoreksi apabila terjadi kesalahan.

6.2.1 Menambah Data Gambar

Untuk menambah data gambar ke dalam ArcMap, File > Add Data di toolbar
menu. Kemudian pilih gambar yang di perlukan.

6.2.2 Membuat Layer atau Shapefile

Langkah – langkah untuk memulai digitasi onscreen adalah sebagai berikut
berikut ini:
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1. Identifikasi terlebih dahulu objek objek yang akan didigitasi.

2. Setelah objek teridentifikasi, buatlah shapefile untuk masing masing
kategori objek melalui ArcCatalog. Untuk membuka ArcCatalog klik menu
ArcCatalog di menu toolbar.

3. Setelah ArcCatalog terbuka, masuklah ke dalam folder dimana shapefile
yang akan dibuat ingin disimpan. Pada contoh berikut kita akan
menyimpan shape file yang akan dibuat di folder D:\TBI GIS
Training\Workspace.

4. Klik kanan jendela sebelah kanan ArcCatalog, kemudian akan muncul
beberapa pilihan, kemudian klik New > pilih Shapefile.

5. Kemudian akan muncul jendela “Create New Shapefile”. Isikan nama
shapefile yang akan dibuat di text box Name, dan tentukan jenis feature
(Feature Type) di dropdown list Feature Type.

6. Misalkan Anda akan mendigitasi objek jalan, maka isikan “Jalan”
dalam text box Name, kemudian pilih Polyline di dropdown list Feature
Type sebagai jenis feature nya.
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7. Feature Type atau jenis feature merupakan representasi objek objek dalam
dunia nyata ke dalam bentuk geometri yang lebih sederhana. Misalnya
untuk objek yang memanjang seperti jalan, pipa air, telkom, jaringan
listrik, dan lain lain direpresentasikan dalam betuk garis (Line/Polyline).
Untuk objek objek yang berbentuk luasan seperti sawah, kolam, rumah,
batas desa, dan lain lain direpresentasikan dalam bentuk polygon. Untuk
objek objek yang berbentuk titik titik seperti tower, tiang listrik, sumur
bor, dan lain lain dipresentasikan dalam bentuk point

6.2.3 Menentukan Sistem Koordinat Shapefile

1. Untuk menentukan sistem koordinat shapefile yang akan dibuat, tekan
tombol Edit, kemudian akan muncul jendela “Spatial Reference Properties”
seperti tampak pada gambar di bawah ini
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2. Tekan tombol Select, sehingga muncul jendela “Browse for Coordinat
System”, kemudian pilih pilihan Geographic Coordinate Systems seperti
gambar berikut. Misalkan kita tentukan sistem koordinatnya adalah
geodetic dengan datum WGS 1984, maka pilih world, kemudian pilih WGS
1984.prj.
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3. Apabila shape file telah berhasil dibuat, akan tampak di jendela kanan Arc
Catalog.
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6.2.4 Digitasi

1. Setelah shapefile dibuat, selanjutnya siap untuk dilaksanakan proses
digitasi. Buka kembali ArcMap, kemudian tambahkan shapefile shapefile
yang akan digitasi, mengunakan tombol Add Data.

2. Untuk memulai digitasi, pilih menu Editor > Start Editing

3. Kemudian akan muncul jendela seperti gambar di bawah ini. Dalam jendela
tersebut akan muncul nama nama layer yang akan diedit yang berada
dalam satu folder yang sama. Tekanlah tombol Start Editing untuk memulai
digitasi.

6.2.5 Snapping

Snapping adalah suatu tool yang sangat berguna untuk mendeteksi titik
(Vertex), ujung garis (End), atau tepi (Edge) dari vektor shapefile. Tool ini sangat
bermanfaat untuk menghubungkan atau menghimpitkan antar garis atau titik dalam
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proses digitasi, sehingga bisa mereduksi kesalahan dalam digitasi berupa garis yang
tidak bersambung atau berhimpit.

Untuk mengaktifkan snapping pilih menu File > View > Toolbar > Editor
Snapping. Selanjutnya akan muncul jendela “Snapping Environment”. Berilah tanda
check pada masing masing layer sesuai pilihan pilihan snapping yang diinginkan.

6.2.6 Memulai Digitasi

1. Pada Menu utama pilih View > Toolbars > Editor, kemudian pilihlah layer
yang akan didigitasi di dropdown list Target. Misalnya layer jalan, pada
dropdown list Task pastikan Anda memilih Create New Feature. Kemudian
pilih tombol Sketch Tool, seperti pada gambar dibawah ini :

2. Untuk memulai digitasi arahkan mouse ke objek “jalan” dalam gambar, klik
pada sebuah titik permulaan, kemudian ikuti sepanjang jalan tersebut
dengan mouse, klik pada tiap tiap belokan atau persimpangan jalan (setiap
klik akan menghasilkan vertex), sehingga tergambar garis hasil digitasi
tersebut.

Sketch tool Dropdown 
list target 

Layer yang 
didigitasi 
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Macam Digitasi

a. Digitasi Line

b. Digitasi Polygon

c. Digitasi Point

3. Untuk mendigitasi layer layer yang lain, ganti nama layer pada menu
Target di toolbar menu Editor.

4. Untuk menghentikan digitasi, cukup double click pada titik akhir digitasi.
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6.2.7 Menyimpan Hasil Digitasi

Untuk menyimpan hasil digitasi, klik menu Editor > Save Edits. Untuk
menghentikan digitasi pilih Stop Editing.
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7 EDITING DATA SPASIAL DAN ATRIBUT

7.1 Editing Data Atribute

1. Pilih layer yang akan diedit

2. Klik tombol Editor Toolbar yang berada pada Toolbar

3. Klik Editor menu dan klik start editing

4. Klik kanan, pilih Open Attribute Table

5. Klik baris yang akan diedit
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7.2 Editing Data Grafis

7.2.1 Membuat Objek Point atau Vertex dengan Koordinat

1. Set Task Current dengan memilih Create New Feature

2. Set Target untuk memilih layer aktif

3. Klik point menggunakan Sketch Tool ( gambar pensil )

4. Tekan F6 untuk memasukkan nilai koordinat, kemudian tekan Enter

5. Masukan Koordinat X dan Y, tekan Enter

7.2.2 Memotong Polygon Menjadi Dua Bagian

1. Klik Editormenu dan klik start editing

2. Klik Polygon yang akan di potong

3. Klik Edit Task, Pilih Cut Polygon Feature
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4. Klik Sketch Tool ( gambar pensil )

5. Buat garis pemotong, klik kanan, tekan F2 untuk mengakhiri

6. Polygon akan terbagi menjadi dua.

7.2.3 Merge Objek

1. Klik tombol Editor Toolbar yang berada pada Toolbar

2. Klik Editormenu dan klik start editing

3. Pilih Objek yang akan di merge

4. Klik tombol Editor Toolbar

5. Pilihmerge
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7.2.4 Memotong Polygon dengan Polygon Lain

1. Klik tombol Editor Toolbar yang berada pada Toolbar

2. Buat Objek baru diatas objek

3. Pilih Objek yang akan digunakan untuk memotong



51

 51 

4. Klik tombol Editor Toolbar

5. Pilih Clip, chek Discard the area that intersects

6. Klik OK

7.2.5 Intersect Objek

1. Klik tombol Editor Toolbar yang berada pada Toolbar

2. Pilih Objek objek yang memiliki intersect
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3. Klik tombol Editor Toolbar

4. Pilih intersect

5. Akan tampak polygon hasil intersect

6. Klik tombol Editor Toolbar

7. Pilih clip, kemudian pilih Preserve Area atau Discard Area

8. Klik OK

7.2.6 Membuat Multipart Line atau Polygon

1. Buat Polygon atau Line
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2. Setelah selesai, klik kanan pilih finish Part

3. Kemudian buat lagi Polygon atau Line

4. Setelah selesai, klik kanan pilih finish Sketch (F2)
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7.2.7 Reshaping Polygon atau Line

1. Klik Task pada Editing Toolbar, pilih Reshape Feature

2. Klik Editing Tool

3. Pilih Polygon atau garis yang akan direshape

4. Klik Skecth Tool pada Editor Toolbar

5. Buat garis baru pada objek, tekan F2

7.2.8 Split Line

1. Klik tombol Editor Toolbar yang berada pada Toolbar

2. Pilih Objek garis yang akan di Split

3. Klik Split Tool

4. Klik Spot pada garis yang akan displit
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7.2.9 Memotong Garis dengan Batas Garis

1. Klik Task pada Editing Toolbar, pilih Extend/Trim Feature

2. Klik Editing Tool

3. Pilih garis yang akan dipotong

4. Klik Skecth Tool pada Editor Toolbar

5. Buat batas garis pemotong, tekan F2
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7.2.10 Menambah Panjang Garis (Extend)

1. Klik Task pada Editing Toolbar, pilih Extend/Trim Feature

2. Klik Editing Tool

3. Pilih garis yang akan diperpajang

4. Klik Skecth Tool pada Editor Toolbar

5. Buat batas garis batas, tekan F2

7.3 Spatial Adjustment

Spatial Adjustment adalah proses pembetulan data spasial agar
sesuai/mendekati karakteristik data yang benar sesuai dengan kaidah GIS data dan
logika kebenaran data dan informasi.

Proses Spatial Adjustment bisa berupa :

1. Transformasi

2. Penarikan obyek (rubber sheet)

3. Penyesuaian obyek pada batas tepi peta (edgematching)
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Perbedaan antara Rubbersheeting dengan Edgematching adalah
Rubbersheeting bisa merubah bentuk di semua segment line, bisa dilakukan multiple
links untuk menambah akurasi feature sedangkan Edgematching akan
merubah/mempengaruhi vertex terakhir dari segment line saja. Rubbersheeting bisa
dilakukan pembatasan pada area mana akan dilakukan justifikasi.

7.3.1 Transformasi

Adalah salah satu tool dalam lingkup Spatial Adjustment yang berfungsi untuk
mentransform (merubah nilai koordinat) dari suatu feature sehingga akan
menghasilkan feature yang baru dengan koordinat yang berbeda dengan koordinat
aslinya, sedangkan bentuk dari feature itu sendiri akan dipertahankan sesuai aslinya.

Transformasi memerlukan paling tidak 4 (empat) titik awal dan 4 (empat) titik
target. Semakin banyak jumlah titik sekutu akan semakin baik hasil yang dicapai.
Adapun langkah langkah transformasi adalah sebagai berikut:

1. ArcMap > Add Data

2. Klik Editor > Start Editing

3. Klik Editor > Option > masukan snapping tolerance, lakukan pengukuran
jarak terlebih dulu untuk menentukan snapping tolerance nya.

4. Klik Editor > Snapping, check semua checkbox yang ada

5. Klik Spatial adjustment, pilih Transfomasi Affine

6. Klik Spatial Adjustmen > Set Adjust Data, check data yg akan

ditransformasi
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7. Create link transformasi:

8. Klik Links > View link table utk melihat nilai titik sekutu transformasi Klik
AdjustsFinish:

9. Membuat link table:

Parameter nilai koordinat transformasi dapat dibuat dengan membuat
table koordinat sekutu pada text file (Notepad). Formatnya adalah sbb:
<ID> <dari x> <dari y> <x tujuan> <y tujuan>
Anda tidak perlu menuliskan judul table. File ini akan disimpan format txt file,
dan digunakan dalam proses transformasi dengan cara memanggil fie tsb
dengan mengklik slinkssopen links file
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7.3.2 Rubber Sheeting

1. ArcMap, Add data

2. Editor > Start Editing

3. Editor > Option, snapping tolerance

4. Editor > Snapping, check vertex, edge, end checkbook

5. Klik Spatial Adjustment > Rubbersheeting

6. Klik Spatial Adjustment > Adjust Data, centang pada peta2 (source)
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7. Klik Spatial Adjustment > Option

8. Pilih source dan target layer

9. Klik Link, created 4 link

10. Buat limit area
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11. Adjust

12. Delete limit area

7.3.3 Edgematching

1. ArcMap> Add data

2. Editors Start Editing

3. Editors Option, snapping tolerance

4. Editors Snapping, check vertex, edge, end checkbox

5. Klik Spatial Adjusment Edge Snap

6. Klik Spatial Adjusmenr Adjust Data, check peta2 source

7. Klik Spatial Adjustment Option

8. Pilih source dan target layer

9. Edge Snap
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8 TOPOLOGY GEODATABASE

Geodatabase merupakan database relasional yang mencakup informasi
geografis. Geodatabase memuat kelas kelas/golongan feature dan table. Kelas kelas
feature dapat diorganisasikan ke dalam set data feature.

Topology adalah pendefinisian secara matematis yang menerangkan hubungan
relative antara objek yang satu dengan objek yang lain. Dalam GIS topology
didefinisikan oleh user sesuai dengan karakteristik data seperti line, polygon maupun
point/titik. Setiap karakteristik data tertentu mempunyai rule/aturan tertentu. Rule
atau aturan tersebut secara default telah disediakan oleh software GIS.

8.1 Menyiapkan Geodatabase

Untuk membangun geodatabase, kita dapat melakukannya dengan
menggunakan ArcCatalog. Kita juga dapat mengimpor data yang sudah ada,
menggunakan Unified Modellig Language (UML) dan Computer Aided Software
Engineering (CASE) Tools, atau kombinasi dari keduanya.

8.1.1 Membuat Tema atau Feature Dataset di ArcCatalog

1. Buka program ArcCatalog

2. Selanjutnya pada ArcCatalog. Browse pada lokasi dimana anda akan
menyimpan database. Buat Personal Geodatabase Latihan di folder
Workspace.
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3. Klik kanan pada folder workspace, atau taruh kursor di folder workspace
lalu pada window data klik kanan. New > Personal Geodatabase.

4. Beri nama file personal geodatabase dengan mengetikkan LATIHAN.

5. Selanjutnya klik kanan mouse setelah mengarahkan mouse pada database
latihan. Kemudian pilih New > Feature Dataset.
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6. Pada Name dari Feature dataset ketik Landcover.

7. Selanjutnya akan tampil kotak dialog yang berisi pendefinisian koordinat
sistem yang akan digunakan untuk feature dataset.
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8. Pada layar akan tampil parameter parameter yang telah didefinisikan
untuk sistem koordinat ini.

9. Sekarang kita perlu memberi nilai pada X/Y Domain yang merupakan
batas tepi dari tampilan peta yang akan kita tampilkan. Masukan nilai
MinX, MinY, MaxX dan MaxY seperti yang tertera pada gambar berikut ini.

10. Setelah itu tekan tombol OK. Tekan lagi tombol OK pada kotak dialog
pembentukan Feature Dataset.
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11. Sekarang anda memiliki tema Landcover sebagai Fetaure Dataset pada
ArcCatalog dengan Nama Landcover.

12. Selanjutya kita akan membuat FeatureClass yang merupakan anggota dari
Feature Dataset Landcover Siak.

8.1.2 Membuat Feature Class

Arahkan kursor ke Feature Dataset Landcover klik kananmouse, kemudian pilih
New > Feature Class.

Pada kotak dalog yang muncul. Isikan nama unsur seperti yang disepakati pada
desain. Kita mulai dengan Batas Kabupaten yang nama unsurnya Landcover. Ketik
Nama Lancover Siak, dan isi alias dengan siak 2008.
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Pada kotak dialog berikutnya yang muncul biarkan pilihan Default,
kemudian tekan tombol Next.

Pada kotak dialog yang selanjutnya muncul kita perlu mengisikan field atribut
yang telah disepakati. Sebelumnya pelajari terlebih dahulu desain basis data untuk
tabel Landcover Siak berikut ini.
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8.1.3 Memasukan data shape file ke database yang telah dibuat.

Kita akan menggunakan ArcMap untuk memasukan data ke dalam Database.
Hal ini dikarenakan bekerja menggunakan Arcmap lebih fleksibel dibandingkan dengan
ArcCatalog.

1. Buka ArcMap. Dari Start>Programs>ArcGIS>ArcMap.

2. Klik pada tombol Add Data, untuk membuka data.

3. Kemudian Browse lokasi shape file yang akan dimasukkan (D:\TBI GIS
Training\Workspace\tbi_siak_lc2008.shp) kemudian klik Add .

4. Untuk meLoad data terlebih dahulu kita klik kanan pada layer
tbi_siak_lc2008 kemudian pilih Data > Export.
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 5. Setelah muncul Tab Export data, klikkemudian akan muncul Tab Saving
Data

6. Setelah muncul Tab Saving Data, pada Save as Type kita pilih Personal
Geodatabase feature classes, kemudian pada Look in kita pilih Featuredata
Set Landcover_Siak , kemudian Name kita isi dengan LC_SIAK2008
kemudian klik Save.
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8.2 Membangun Topology pada Geodatabase

8.2.1 Kesalahan Topology

Beberapa tipe kesalahan topology yang akan dikoreksi dalam latihan ini adalah
sebagai berikut:

a) Polygon

1. Must Not Overlap

Subtract: Menghapus bagian yang overlap dari masing2 feature dan
akan meninggalkan area yang kosong pada daerah error. Perbaikan ini
bisa diterapkan ke satu atau lebih kesalahan yang terjadi (terselesi) pada
aplikasi ruleMust Not Overlap errors.

Merge: Menambah/menggabung feature dari feature overlap yang
melangar aturan yg dipakai. Pemilihan feature tergantung justifikasi kita
mana yg akan dipilih sebagai feature yang dianggap salah. Koreksi ini bisa
diterapkan pada satu kesalahanMust Not Overlap saja.

Create Feature: Membuat polygon baru diluar kesalahan yang terjadi
dan menghapus kesalahan yang ada. Koreksi ini bisa diterapkan ke satu
atau lebih kesalahan yang terselect oleh penerapan aturan Must Not
Overlap errors.
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2. Must Not Have Gap

Create Feature: Membuat polygon baru dari garis batas yang saling
membentuk polygon kosong (gap). Koreksi ini bisa diterapkan pada satu
atau lebih kesalahan pada penerapan aturanMust Not Have Gaps errors.

Substract: Menghapus segmen line yang overlapping dari feature2
yang membentuk kesalahan. Anda harus melakukan seleksi lebih dulu
sebelum menghapus obyek dimaksud. Koreksi ini dapat diterapkan pada
satu kesalahanMust Not Overlap saja.

b) Line

1. Must Not Overlap

Substract: Menghapus segmen line yang overlapping dari feature feature
yang membentuk kesalahan. Anda harus melakukan seleksi lebih dulu
sebelum menghapus obyek tersebut. Koreksi ini hanya dapat diterapkan
pada satu kesalahanmust not overlap saja.

2. Must Not Intersect

Subtract: Menghapus segmen line yang overlapping dari feature yang
membentuk kesalahan. Anda harus melakukan seleksi lebih dulu
sebelum menghapus obyek dimaksud. Koreksi ini dapat diterapkan pada
satu kesalahanMust Not Intersect saja.

Split: Memotong feature line yang saling berpotongan menjadi 4 segmen
garis. Koreksi ini bisa diterapkan pada satu atau lebih kesalahan Must Not
Intersect.

3. Must Not Have Dangles

Extend: Menyambung dangle pada akhir segmen line ke feature di
depannya sepanjang toleransi jarak snapping terpenuhi. Jika tidak masuk
dalam toleransi jarak snapping, maka dangle akan tetap dipertahankan
(tidak berubah), hanya obyek yang terselek yg akan di validasi. Koreksi ini
dapat diterapkan ke satu atau lebih kesalahanMust Not Have Dangles.

Trim: Menghapus feature line jika dangle (point) pada akhir intersection
line masuk dalam toleransi jarak snapping yg diterapkan. Koreksi ini dapat
diterapkan ke satu atau lebih kesalahanMust Not Have Dangles.

Snap: Akan menyatukan dangle line ke line terdekat yang masuk dalam
toleransi jarak snapping, target line sendiri posisinya tetap. Akan dicari
endpoint terlebih dulu, vertex dan pada akhirnya garis. Koreksi ini dapat
diterapkan ke satu atau lebih kesalahanMust Not Have Dangles.
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c) Points

Pada jenis kesalahan points hanya ada dua koreksi yang bisa dilakukan yaitu
membiarkannya atau menghapus feature yang dianggap salah.

8.2.2 Bekerja Dengan Topology

Untuk memulai membangun topology dengan menggunakan ArcGIS 9.x dapat
dilakukan tahapan tahapan sebagaimana berikut. Untuk topology data penggunaan
lahan ataupun data data lainya, jendela ArcMap terlebih dahulu di tutup kemudian
proses topology dapat dilakukan pada ArcCatalog dengan langkah langkah sebagai
berikut:

1. Klik kanan pada feature dataset dalam geodatabase yang telah dibangun,
new > topology

2. Akan muncul kotak dialog New topology kemudian klik next
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3. Di sini akan muncul kotak dialog yang mengharuskan kita untuk melakukan
pemilihan (pengaktifan) feature yang akan dilakukan topology dan
pemilihan rule yang akan dipakai terhadap feature tsb.

4. Pada tampilan selanjutnya akan muncul list rule yang bisa kita pilih
sesuai karakteristik datanya.

5. Rule yang dipilih bisa lebih dari satu sesuai dengan karakteristik data yang
akan diterapkan topology.

Lihat ilustrasi berikut ini:
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Untuk data penggunaan lahan berupa polygon dapat kita terapkan dua
aturan (rule) yaitu:

a. Must Not Overlap dan

b. Must Not Gap

6. Pilih rule yang ke 2 seperti gambar berikut:

7. Sehingga akan muncul kotak dialog yang menampilkan ke 2 rule sebagai
berikut:
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8. Klik next > finish. Lakukan proses validasi topology. Setelah itu akan
muncul hasil topology.

8.3 Editing Topology pada ArcMap

Untuk memulai pengeditan topology langkah awal adalah klik ArcMap untuk
menjalankan proses pengeditan polygon polygon yang terdapat pada spatial data yang
terdapat di geodatabase seperti pada gambar berikut.

Pilih feature yang memiliki kesalahan topology (warna merah tua) setelah
feature yang di select/pilih menjadi warna hitam kemudian klik kanan. Untuk
melakukan koreksi data pilih salah satu feature seperti pada gambar berikut.
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Kesalahan topology dikoreksi sesuai dengan tipe kesalahannya sebagaimana
telah dijelaskan pada awal subbab ini.
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9 QUERY DATA

9.1 Bekerja dengan Data Atribut

Seperti yang telah disebutkan di atas, pelatihan ini akan memperkenalkan
Anda dengan kemampuan analisa geografi GIS, termasuk di dalamnya analisa atribut,
analisa spasial, atau integrasi atribut dan analisa spasial. Dalam latihan ini kita akan
mulai menjelajahi dan menganalisa data atribut.

Tiap layer dalam TOC mewakili data spasial yang ditampilkan dalam wilayah
Map Display. Dalam Arcmap kita dapat pula mem browse seluruh atribut yang
berasosiasi dengan tiap layer. Tampilkan seluruh data geografis dalam folder “D:\TBI
GIS Training\Workspace\” dalam data frame Anda. Langkah langkahnya adalah sebagai
berikut:

1. Klik ikon ArcMap dari Start Programs ArcGIS ArcMap

2. Klik tombol Add Data untuk load data geografik dalam file peta Anda.

3. Carilah folder “D:\TBI GIS Training\Workspace\”, pilih data geografik dan
klik tombol Add untuk me loadnya.

9.1.1 Membuka Tabel Atribut

Dengan ArcMap kita mampu melakukan browsing seluruh data atribut untuk
tiap layer. Browsing dapat dilakukan pada seluruh data atribut untuk tiap layer.
Browsing dilakukan dengan cara meng Klik kanan pada layer TOC lalu pilih menu Open
Tabel Atribut.

9.1.2 Mengatur Ulang Kolom

Ketika Anda membuka sebuah tabel, Anda dapat mengatur ulang tampilannya.
Contohnya, Anda dapat memperbesar atau memperkecil lebar tabel yang ditampilkan,
memindahkan kolom, menyembunyikan kolom, mengatur urutan tabel berdasarkan
satu atau beberapa field yang terpilih, atau melakukan freezing pada sebuah field agar
Anda dapat selalu melihat field tersebut saat Anda melakukan scrolling.

a) Latihan mengatur ulang lebar kolom dalam Tabel Attribute of landuse.
Langkah langkahnya adalah sebagai berikut:

1. Arahkan posisi penunjuk mouse di tepi kolom yang akan diatur ulang
ukurannya.

2. Klik dan tarik tepi kolom untuk mengatur ulang lebarnya.

b) Latihan mengatur ulang posisi kolom dalam Tabel Attribute of landuse.
Langkah langkahnya adalah sebagai berikut:

1. Arahkan posisi penunjuk mouse di tepi kolom yang akan dipindahkan.
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2. Klik dan tarik kolom untuk mengubah posisinya

c) Latihan melakukan freezing sebuah kolom dalam Tabel Attribute of landuse.
Langkah langkahnya adalah sebagai berikut:

1. Arahkan posisi penunjuk mouse pada kolom yang akan di freeze.

2. Klik kanan mouse dan pilihl Freeze/Unfreeze Column.

d) Latihan mengatur urutan tabel berdasarkan kolom tertentu dalam Tabel
Attribute of landuse dengan metode menurun (descending) dan menaik
(ascending). Langkah langkahnya adalah sebagai berikut:

1. Arahkan posisi penunjuk mouse pada kolom tertentu.

2. Klik kananmouse dan pilih menu Short Descending.

3. Arahkan posisi penunjuk mouse pada kolom tertentu.

4. Klik kananmouse dan pilih menu Short Ascending.
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9.1.3 Setting Tampilan Tabel

Dengan ArcMap Anda dapat melakukan setting tampilan tabel atribut,
termasuk di dalamnya mengatur jenis huruf, warna, kolom yang ditampilkan, dan nama
samaran kolom.

a) Latihan mengubah jenis huruf menjadi Tahoma dengan warna hijau dan ukuran
huruf 9. Langkah langkahnya adalah sebagai berikut:

1. Klik tombol Options lalu pilih menu Appearance.

2. Set jenis huruf (table font) menjadi Tahoma, ukuran huruf 9, dan warna
huruf hijau dalam window Attributes of landuse.
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b) Latihan mengubah warna huruf menjadi kuning, Langkah langkahnya adalah
sebagai berikut:

1. Klik tombol Options lalu pilih menu Appearance untuk menampilkan
window Table Appearance.

2. Set Selection Color menjadi kuning.

c) Latihan mengeset tampilan Tabel Attribute of landuse agar hanya
menampilkan field yang dikehendaki. Langkah langkahnya adalah sebagai
berikut:

1. Klik kanan pada tombol pada layer landuse lalu pilih menu Properties
untuk menampilkan properti layer landuse.

2. Klik tab Fields.

3. Pilih field yang tidak ingin ditampilkan lalu pada kotak Visible lakukan
unchecked.
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d) Mengubah nama field. Langkah langkahnya adalah sebagai berikut:

1. Klik kanan pada layer landuse lalu pilih menu Properties untuk
menampilkan properti layer dan klik tab Fields.

2. Pilih field yang akan dirubah namanya lalu isi nama samarannya pada text
box Alias.

3. Klik tombol Apply diikuti tombol OK untuk melanjutkan.

e) Memformat field X dengan tiga digit desimal dan menampilkan angka desimal
tersebut. Langkah langkahnya adalah sebagai berikut:

1. Klik kanan pada layer landuse lalu pilih menu Properties untuk
menampilkan properti layer landuse dan klik tab Fields.

2. Pilih field X lalu klik tombol Format.

3. Pilih kategori Numeric dan set Number of decimal places menjadi 3 lalu
pilihlah kotak Path with zeros.

4. Klik tombol OK untuk melanjutkan.

9.1.4 Pemilihan Record

Terdapat beragam cara untuk memilih obyek dalam ArcMap. Salah satu cara
yang dapat digunakan adalah memilih obyek melalui tabel atribut. Dari sebuah tabel,
Anda dapat secara interaktif memilih sebuah record dengan cara memilih record
tersebut atau memilih beberapa record yang memenuhi kriteria tertentu. Pemilihan
record dapat Anda lakukan secara manual.

a) Pilih 10 record pertama pada Tabel Attribute of landuse secara manual.
Langkah langkahnya adalah sebagai berikut:

1. Buka Tabel Attribute of landuse.

2. Tekan Ctrl dan klik record pertama pada kolom paling kiri, tahan dan tarik
penunjuk mouse menuju record ke 4.

b) Menukar record yang terpilih dalam tabel Attribute of landuse (record yang
sebelumnya terpilih menjadi tidak terpilih dan record yang sebelumnya tidak
terpilih menjadi terpilih). Langkah langkahnya adalah sebagai berikut:

1. Klik kanan mouse pada tombol layer landuse.

2. Pilih menu Selection lalu pilih Switch Selection .

c) Memilih seluruh record pada tabel Attribute of landuse. Langkah langkahnya
adalah sebagai berikut:

1. Klik kanan mouse pada tombol pada layer landuse .
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2. Pilih menu Selection lalu pilih Select All .

d) Tidak Memilih satu record pun pada tabel Attribute of landuse. Langkah
langkahnya adalah sebagai berikut:

1. Klik kananmouse pada tombol pada layer landuse.

2. Pilih menu Selection lalu pilih Clear Selected Features.

9.1.5 Loading Data Atribut Eksternal

Penyimpanan data atribut tambahan ke dalam basidata komersial seperti
bBase file (dbf), MS Access (mdb), MS SQL Server, Oracle, DB2, atau Informix
merupakan hal yang lazim dalam lingkup GIS. Dalam latihan berikut ini, Anda akan
belajar cara mengisi data atribut tambahan yang tersimpan dalam format Microsoft
Excel.

Mengisi data atribut tambahan pada peta. Langkah langkahnya adalah sebagai
berikut:

1. Klik tombol Add Data lalu cari folder “:\TBI GIS Training\Statistic\”.

2. Pilih basisdata subdistrict_stat.xls lalu klik tombol Add. Basisdata ini akan
ditambahkan dalam TOC.

9.1.6 Menggabungkan Tabel Atribut

Ketika Anda membutuhkan informasi yang tidak terdapat pada tabel yang
tengah Anda buka, Anda dapat menghubungkan tabel yang tengah Anda buka dan
tabel tambahan yang berisi informasi yang Anda butuhkan. Dalam ArcMap, Anda dapat
melakukan hubungan tersebut dengan cara menghubungkan (joining) atau merelasikan
(relating).

Menghubungkan data atribut tambahan untuk subdistrict_stat ke dalam layer
subdistrict pada map. Langkah langkahnya adalah sebagai berikut:

1. Klik kanan mouse pada tombol layer Subdistrict, pilih Joins and Relates, lalu
klik Join.
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2. Klik nama field pada layer yang akan menjadi dasar penggabungan.

3. Klik menu dropdown untuk memilih tabel yang akan digabungkan pada
layer. Jika tabel tabel yang dimaksud belum terdapat pada peta, klik
tombol browse untuk mencari lokasinya dalam disk Anda.
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4. Klik menu dropdown pada pilihan Choose the field in the table to base the
join on lalu klik nama field dalam tabel yang akan digabungkan.

5. Buka tabel atribut untuk melihat hasil penggabungan.

9.2 Analisa Query dalam Data Atribut

Sebagai bagian dari data geografis, data atribut juga merupakan data mentah
yang sangat penting dalam proses analisa geografis. Anda dapat melakukan beberapa
analisa berdasarkan tipe data ini.

9.2.1 Mencari Obyek Tertentu

Layaknya data GIS, sebuah layer berisi beragam obyek yang mewakili
permukaan bumi. Banyaknya obyek terkadang menjadi masalah ketika Anda mencari
obyek tertentu yang tersimpan bersama ribuan record yang tersusun berdasarkan
informasi spesifik tertentu seperti ID, nama, dan deskripsi.

Mencari Nama Kecamatan = Minas. Langkah langkahnya adalah sebagai
berikut:

1. Buka tebel Attribute of Subdistrict lalu klik tombol Option

2. Pilih perintah Find and Replace.

3. Ketik “Minas” dalam text box Find what lalu klik tombol Find Next untuk
mendapatkan record nya.
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4. Klik tombol Find next untuk mendapatkan record “Minas” lainnya. Jika
tidak terdapat record “Minas”, maka ArcMAp akan memberikan
peringatan.

9.2.2 Mengkalkulasi Statistik Obyek

Terkadang informasi atribut tentang obyek peta tidak terorganisir sesuai
keinginan Anda, contohnya, Anda memiliki data populasi per kecamatan sementara
yang Anda inginkan adalah data populasi per kabupaten. Dengan merekapitulasi data
dalam tabel, Anda dapat memperoleh beragam data statistik, temasuk nilai rata rata,
nilai maksimum dan minimum, serta informasi lainnya yang Anda inginkan.

ArcMap akan membuat sebuah tabel baru yang berisi informasi statistik
tersebut. Kemudian Anda dapat menghubungkan tabel tersebut dengan tabel atribut
pada layer tertentu. Dengan demikian Anda dapat memberikan simbol, label, atau
mencari obyek layer tertentu berdasarkan nilainya pada ringkasan statistik.

Latihan merekapitulasi seluruh obyek yang terdapat pada Layer Subdistrict
berdasarkan type nya. Langkah langkahnya adalah sebagai berikut:

1. Klik kanan mouse pada field yang akan Anda rekapitulasi lalu klik
Summarize.

2. Tandai kotak yang bersebelahan dengan ringkasan statistik yang ingin Anda
sertakan dalam tabel keluaran.
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3. Ketik nama dan lokasi tabel keluaran yang akan Anda buat atau klik ikon
browse untuk mencari lokasi penyimpanan yang Anda inginkan.

4. klik tombol OK untuk melanjutkan, lalu klik tombol Yes untuk menambah
tabel baru pada peta.

5. Anda dapat melihat di TOC terdapat tabel atribut baru yang bernama Sum
output. Bukalah tabel keluaran tersebut.

9.2.3 Memilih Obyek secara Interaktif menggunakan Pernyataan SQL

Seperti yang telah kita lakukan sebelumnya, Anda dapat memilih satu atau
lebih obyek melalui tabel atribut. Dengan ArcMap Anda dapat pula memilih beberapa
obyek tertentu secara manual atau menggunakan pernyataan SQL secara interaktif.
Ketika menggunakan SQL, Anda harus membuat ekspresi pada dialog box Select By
Attributes. Dalam ArcMap, ekspresi ini hanya berupa WHERE saja (gunakan format
ANSI SQL). SELECT * FROM NameOfTableWHERE the Expression
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Memilih seluruh record pada tabel Attribute of Landuse yang memiliki tipe
IUPHHK HA menggunakan pernyataan SQL. Langkah langkahnya adalah sebagai
berikut:

1. Buka tabel Attributes of Landuse.

2. Klik menu Selection dan pilih Select By Attributes.

3. Pastikan layer terpilih adalah layer Landuse (periksa di text box Layer).

4. Tulis pernyataan SQL: “Jenis_LU”= “IUPHHK HA”, lalu klik tombol Apply
untuk memilih seluruh record yang memiliki Type IUPHHK HA .

9.3 Memanipulasi Data Atribut

Terkadang sebelum kita dapat melakukan analisa lebih jauh, kita perlu
mempersiapkan data, seperti klarifikasi dan kalkulasi berdasarkan beberapa persamaan
matematis.

9.3.1 Menambah Kolom

Untuk menambah sebuah field, Anda perlu menentukan tipe field, presisi, dan
skalanya jika field memiliki tipe numerik. Untuk field bertipe string, Anda perlu
menentukan tipe field dan panjangnya. Menambah kolom baru bernama “luas”
dengan tipe short integer pada tabel Attribute of subdistrict. Petunjuk:

1. Buka ArcCAtalog dan temukan subdistrict shapefile dalam folder “D:\TBI
GIS Training\Workspace\”

2. Klik ganda subdistrict untuk membuka folder “D:\TBI GIS
Training\Workspace\subdistrict”.

3. Tambahkan kolom baru bernama “LUAS” dengan tipe “Short Integer” dan
nilai Precision 2.

4. Kembali ke ArcMap lalu bukalah layer tabel atribut subdistrict.

9.3.2 Melakukan Persamaan Matematis

Dalam kasus kasus tertentu, Anda mungkin ingin melakukan kalkulasi
matematis untuk mengatur nilai suatu field untuk sebuah record atau bahkan seluruh
record. Kalkulator field ArcMap dapat membantu Anda melakukan perhitungan
sederhana hingga perhitungan yang kompleks pada setiap record yang terpilih.
Mengubah seluruh nilai item LUAS pada layer subdistrict menjadi hectares / 100.
Petunjuk:

1. Buka layer attribute.

2. Tampilkan toolbar Editor, pilih Start Editing untuk mulai mengedit.
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3. Klik kananmouse pada kolom “LUAS” lalu

4. Ketik pernyataan untuk mengisi kolom LUAS dengan hectares / 100.

5. Klik tombol OK untuk melanjutkan.

 

9.4 Menganalisa Data Atribut melalui Obyek Grafik

Sebuah grafik memberikan informasi tentang obyek peta dan hubungan antar
obyek dalam bentuk yang interaktif dan mudah dipahami. Grafik dapat pula
menampilkan informasi tambahan tentang obyek pada peta atau menunjukkan
informasi yang sama dengan cara yang berbeda. Grafik melengkapi peta karena
membawa informasi yang mampu menyajikan informasi yang sebetulnya perlu waktu
untuk meringkasnya dan memahaminya, sebagai contoh, Anda dapat secara cepat
membandingkan obyek untuk melihat atribut obyek mana yang memiliki nilai lebih
kecil atau lebih besar

9.4.1 Membuat Grafik Baru

Tampilkan jumlah tiap tipe subdistrict dalam bentuk grafik. Petunjuk:

1. Klik tombol Options lalu pilih perintah Create Graph.
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2. Pastikan Anda memilih layer Subdistrict sebagai sumber data sementara
nilanya diambil dari field hectares dan kecamatan.
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3. Beri tabel tersebut judul dan sub judul pada kotak Title dan Sub title, dan
pilihan lainnya lalu klik tombol Finish.
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10 SPATIAL ANALYST (ArcToolbox)

Salah satu kelebihan dari SIG adalah mampu melakukan analisa spasial.
Terdapat dua modul penting yang dapat digunakan dalam melakukan analisa spasial
yaitu Analysist Tools (vector) dan Spatial Analyst Tool (raster). modul kali ini kita akan
berkenalan dengan beberapa performa ArcGis untuk melakukan beberapa analisa data
menggunakan ArcToolBox. Analisa Tool diperoleh pada section Analysis Tool yang
terdiri dari beberapa bagian utama yaitu;

1. Extract, yang terdiri dari 4 fungsi yaitu Clip, Select, Split dan Table Select

2. Overlay, terdiri dari Erase, Identity, Intersection, Symmetrical Difference,
Union dan Update

3. Proximity, terdiri dari Buffer, Multiple Ring Buffer, Near dan Point Distance

4. Statistic terdiri dari Frequency dan Summary Statistic
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10.1 Extract

10.1.1 Clip

Clip berfungsi untuk membuat Theme baru yang dihasilkan dari proses
pemotongan oleh Clip Theme terhadap sebuah Theme Input. Syarat clip theme yaitu
bertipe feature polygon, sedangkan input theme dapat bertipe polygon, line atau point.

1. Klik ArcToolbox Analyst Tool Extract Clip

2. Lanjutkan dengan mengklik ikon Next kemudian pilih input theme dan clip
theme
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3. Isi output file nya dan tentukan tempat penyimpanan file tersebut dengan
mengklik ikon

4. Klik Finish untuk menyelesaikan proses tersebut

5. Maka hasil clip berupa data seperti berikut ini:

10.1.2 Select

Fungsi ini adalah fungsi Query Database (SQL) seperti yang telah kita pelajari
sebelumnya

10.1.3 Split

Untuk perintah split hampir sama dengan perintah clip, tetapi perbedaannya
adalah:

1. data yang menjadi clip featurenya (split) harus mempunyai kolom pada
table atribut yang memiliki type recordnya dalam bentuk karakter
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2. output tersimpan didalam folder, dan hasilnya adalah terpisah untuk tiap
feature split

10.1.4 Table Select

Fungsi ini adalah seperti fungsi select dan hasilnya adalah berupa table

10.2 Overlay

10.2.1 Erase

Perintah ini digunakan untuk membuat sebuah feature baru dengan cara
memotongkan sebuah feature dengan feature pemotong. Feature yang terbentuk
adalah bagian yang tidak termasuk dalam feature pemotong. Perintah ini seperti
perintah pada Clip.

1. Klik ArcToolbox Analyst Tool Overlay Erase
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2. Lanjutkan pilih input Feature,kemudian add

3. Isi Erase Feature file nya tersebut dengan mengklik ikon
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4. Isi output file nya dan tentukan tempat penyimpanan file tersebut dengan
mengklik ikon,kemudian klik OK

10.2.2 Identity

Perintah ini digunakan untuk mengambil data atribut dari feature lain yang

berpotongan. Perintah ini seperti perintah pada Split.

1. Klik ArcToolbox Analyst Tool Overlay Identity
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2. Lanjutkan pilih input Feature,kemudian add

3. Isi output file nya dan tentukan tempat penyimpanan file tersebut
dengan mengklik ikon,kemudian klik OK
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10.2.3 Intersect

Intersect digunakan untuk menggabungkan dua set data spasial yang saling
berpotongan, hanya feature feature yang terdapat di dalam extent kedua theme ini
yang akan ditampilkan. Atribut yang terdapat pada kedua theme ini juga akan
digabungkan bersama shapefile yang baru. Theme input ini bisa berupa line atau
polygon, sedangkan theme untuk overlaynya harus bertipe polygon.

1. Aktifkan fungsi ‘Intersect’ pada kotak dialog Overlay
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2. Pilih input theme dan theme overlay nya

3. Isi output file nya dan tentukan tempat penyimpanan file tersebut

4. Klik Finish untuk menyelesaikan proses tersebut

10.2.4 Symmetrical Difference

Perintah ini seperti perintah intersect, hanya saja feature yang terbentuk
merupakan feature feature yang tidak saling berpotongan.
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10.2.5 Union

Fungsi Union digunakan untuk membuat theme baru hasil penggabungan dari
dua theme. Theme yang telah digabung ini berisikan feature feature dan atribut
dari dua theme yang digabungkan tersebut.

1. Aktifkan fungsi ‘Union’ pada kotak dialog Overlay

2. Pilih input theme dan theme overlay nya
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3. Isi output file nya dan tentukan tempat penyimpanan file tersebut

4. Klik Finish untuk menyelesaikan proses tersebut

10.2.6 Update

Perintah ini seperti perintah pada Clip.
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10.3 Proximity

10.3.1 Buffer

1. Aktifkan fungsi Buffer pada kotak Proximity

2. Lanjutkan pilih input Feature,kemudian add
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3. Lanjutkan pilih input Feature,kemudian save

4. Lanjutkan ketik distance (Jarak yang akan digunakan untuk
Buffer).Dalam contoh ini dipakai jarak buffer 50 meter.

5. Setelah semua proses telah lengkap,klik OK
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10.3.2 Multiple Ring Buffer

1. Aktifkan fungsi ‘Intersect’ pada kotak dialog Overlay

2. Lanjutkan pilih input Feature
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3. Lanjutkan pilih input Feature

4. Lanjutkan pilih input Feature

10.3.3 Near (menghitung jarak terdekat)
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10.3.4 Point Distance
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11 LAYOUT PETA
11.1 Pengaturan Layout

11.1.1 Menampilkan atau Mengatur Peta

1. Buka file PetaAdministrasiRiau.mxd.

2. Aktifkan layer detail.

3. Klik kanan pada bps_riau_district2003 > Properties > Symbology. Atau klik
dua kali pada file yang dipilih.

4. Arahkan ke tab Symbology, pilih Categories > Unique Values.

5. Pilih NMKAB pada kolom Value Field.

6. Klik Add All Values, uncheck all other values.

7. Pindahkan ke Layout View dengan klik View > Layout View. Atau klik ikon di
bagian bawah halaman data.

8. Setelah mengganti ke Layout View, maka peta akan disajikan pada halaman
layout. Halaman layout ini menyajikan satu atau lebih data frame.

9. Layout toolbar memuat tools yang dipakai untuk mengedit layout. Tools
tersebut antara lain.

Fixed Go to Next Toggle Draft

Zoom in/ Zoom in/ Zoom Extent/ Mode Change
zoom out Zoom out 100%Previous Extent Layout

Zoom
Pan Whole Zoom Control Focus Data

Page Frame

a. Zoom in/Zoom out: Memperbesar atau memperkecil peta pada layer
yang aktif di halaman layout.

b. Pan: Menggerakkan peta pada layer yang aktif di halaman layout.

c. Fixed zoom in/zoom out: Memperbesar atau memperkecil peta pada
layer yang aktif dengan skala yang diberikan langsung oleh ArcMap.
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d. ZoomWhole Page: Menampilkan seluruh halaman layout.

e. Zoom 100%: Menampilkan peta yang aktif dengan skala 1:1.

f. Go to next extent/previous extent: Ke tampilan peta sebelum atau
sesudah.

g. Zoom control: Menampilkan peta dengan skala perbesaran yang
diinginkan pengguna.

h. Toggle Draft mode: Digunakan untuk membuat layout tanpa tampilan
peta, sehingga pengguna tidak perlu menunggu gambaran peta. Pada
toggle draft mode, peta diwakili dengan judul layer.

i. Focus data frame: Untuk fokus pada salah satu data frame.

j. Change layout: Untuk mengubah layout. Pengguna dapat memilih
template peta yang diinginkan.

Perlu dicatat bahwa setiap project di ArcGIS hanya dapat menyajikan satu
layout.

11.1.2 Mengatur Proyeksi

1. Klik kanan pada layer yang aktif, lalu klik Properties > Data Frame
Properties > Coordinate System.

2. Akan muncul kotak Data Frame Properties > Coordinate System.

3. Pada Kotak Select a coordinate system, pilih Predefined > Geographic
Coordinate System > World > WGS1984.

11.1.3 Mengatur Halaman Layout

1. Untuk mengatur lebar halaman. Klik kanan halaman pada halaman layout
lalu pilih Page and Print Setup. Akan muncul kotak Page and Print Setup

2. Langkah yang lain adalah dengan meng klik menu view > Page and Print
Setup. Kemudian akan muncul kotak dialog Page and Print Setup.
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3. Kotak dialog Page and Print Setup digunakan untuk mengubah orientasi
portrait menjadi landscape atau sebaliknya. Ukuran halaman dapat
diubah dengan mengeditnya di kotak properties.
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11.2 Penambahan Unsur unsur Peta

11.2.1 Menambahkan Koordinat Peta

1. Klik kanan pada data frame, pilih Properties.

2. Atau ke menu View > Data Frame Properties.

3. Kotak dialog Data Frame Properties > Grids > New Grid.
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4. Selanjutnya akan muncul kotak dialog Grids and Graticules Wizard.

5. Kotak dialog Grid and Graticules Wizard akan membimbing pengguna
melewati 4 tahap untuk melengkapi peta dengan garis koordinat dan
koordinatnya. Pada tahap pertama pengguna akan memilih jenis koordinat
dan garis koordinat yang diinginkan. Klik Next.

6. Tahap kedua akan membimbing pengguna untuk membuat garis koordinat
dan menentukan interval garis koordinat pada peta. Atur interval koordinat
pada 2 menit, bila Anda merasa interval terlalu rapat ubah dengan interval
yang lebih besar. Klik Next.
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7. Tahap ketiga adalah untuk mengedit label koordinat dan garis koordinat.
Atur ukuran huruf menjadi 8, dengan mengubah di kotak text style. Atau
sesuaikan ukuran huruf sesuai yang Anda inginkan. Klik Next.

8. Tahap keempat untuk membuat batas kotak koordinat pada peta. Setelah
selesai, klik Finish.
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11.2.2 Menambahkan Skala

1. Klik Insert > Klik Scale Bar untuk menambahkan skala.

2. Kotak dialog Scale Bar Selector akan muncul. Skala dapat diedit dengan
mengklik Properties.

3. Pilih bentuk skala yang diinginkan, dan klik OK.

4. Klik skala dan tarik ke halaman yang kosong pada halaman layout.

5. Pengguna juga dapat menambahkan skala teks. Klik Insert > Scale Text.
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6. Lalu akan muncul kotak Scale Text Selector.

7. Teks skala dapat diubah dengan memilih Properties. Setelah pengguna
memilih jenis skala yang diinginkan, klik Ok.

11.2.3 Menambahkan Panah Penunjuk Arah

1. Klik Insert > North Arrow.
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2. Selanjutnya kotak dialog North Arrow Selector akan muncul. Panah
penunjuk arah dapat diedit dengan mengklik tombol Properties.

3. Pilih Panah penunjuk arah yang diinginkan, lalu klik Ok.

4. Klik panah penunjuk arah, tarik ke halaman kosong di halaman layout.

11.2.4 Menambahkan Judul Peta

1. Klik menu Insert > Title.
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2. Tulis judul yang mewakili peta pada kotak judul. Untuk mengubah bentuk
dan ukuran judul sesuai kebutuhan, klik kanan pada kotak judul dan pilih
Properties. Setelah itu akan muncul kotak Properties. Ketiklah judul pada
kolom text yang telah disediakan.

11.2.5 Menambahkan Object pada Layout

1. Klik Insert > Object.
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2. Akan muncul kotak Insert Object. User dapat memilih tipe objek yang akan
di tampilkan pada layout. Bila objek gambar telah ada, klik Create
From File, dan pilih objek yang ingin ditampilkan pada layout.

3. Letakkan objek pada halaman layout kosong.

11.2.6 Menambahkan Teks pada Layout

1. Klik Insert > Text.

2. Kemudian akan muncul kotak teks pada halaman layout. Klik kanan pada
kotak teks tersebut, pilih Properties. Akan muncul kotak dialog Properties.
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3. Tulis teks untuk ditampilkan pada layout peta. Untuk mengatur jenis

tulisan klik Change Symbol, maka selanjutnya akan muncul kotak dialog

Symbol Selector.

4. Klik Ok.
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11.2.7 Membuat Extent Rectangle

Extent rectangle berguna apabila pengguna ingin menampilkan lebih dari satu
data frame, misalnya untuk insert peta. Langkah – langkahnya sebagai berikut:

1. Klik kanan pada layer peta yang lebih besar, lalu klik Properties.

2. Akan muncul kotak dialog Data Frame Properties. Klik Extent Rectangles,
lalu pilih data yang akan dijadikan inset peta di kotak Other Data Frames.
Klik untuk memasukkan data satu per satu atau jika seluruh data ingin
dijadikan inset, klik OK.

3. Setelah itu, pada halaman layout akan tampil peta dan peta inset.
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11.2.8 Menambahkan Legenda

1. Klik menu Insert > Legend

2. Kotak dialog Legend Wizard akan muncul. Kotak ini akan membimbing
pengguna melalui 5 tahap dalam membuat legenda sesuai dengan yang
diinginkan.

a. Tahap pertama akan membimbing pengguna untuk memilih
data data yang ingin ditampilkan pada kotak legenda. Pilih data
yang diinginkan untuk ditampilkan di kotak legenda. Klik Next.

b. Tahap kedua membimbing pengguna untuk membuat judul legenda
sesuai dengan yang diinginkan.

c. Tahap ketiga adalah untuk membuat kotak legenda sesuai yang
diinginkan pengguna. Klik menu drop down border untuk menambah
bingkai kotak legenda. Pilih border garis hitam dengan ketebalan 3. klik
menu drop down backdround untuk memilik warna latar. Pilih warna
latar olive.

d. Tahap keempat untuk mengedit ukuran dan bentuk lambang yang
mewakili setiap data sesuai yang diinginkan pengguna. Misalnya,
lambang untuk data persil dapat diubah ukurannya dan bentuknya
menjadi oval, lingkaran atau kotak.

e. Tahap terakhir membimbing pengguna untuk menentukan jarak antara
bagian bagian yang disajikan pada legenda peta. Klik Finish setelah
menyelesaikan Legend Wizard.

Berikut contoh tampilan layout yang telah selesai.
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11.3 Menyimpan Peta

Untuk menyimpan peta baru, klik menu File > Save As. Atau dengan meng klik
ikon. Peta dapat disimpan dalam ekstensi mxd dan mxt. Ekstensi mxd adalah untuk
menyimpan peta dalam bentuk dokumen project, sedangkan ekstensi mxt untuk
menyimpan peta dalam bentuk template.

11.4 Ekspor Peta

Klik menu File > Export Map. Peta dapat diekspor ke berbagai macam format,
seperti PDF, JPEG, TIFF, dan lain lain.
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11.5 Mencetak Peta

1. Klik File > Print

2. Kotak Print akan muncul. Setup cetak dapat disesuaikan dengan meng klik
Setup > OK.
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3. Maka akan tampil kotak dialog Print untuk memilih printer, ukuran kertas
dan kualitas cetakan.


